<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.3.1</td>
<td>Open To Do component</td>
<td>50</td>
</tr>
<tr>
<td>4.3.2</td>
<td>Create Task</td>
<td>51</td>
</tr>
<tr>
<td>4.3.3</td>
<td>Edit Task</td>
<td>52</td>
</tr>
<tr>
<td>4.4</td>
<td>CALENDAR</td>
<td>55</td>
</tr>
<tr>
<td>4.4.1</td>
<td>Open Calendar</td>
<td>55</td>
</tr>
<tr>
<td>4.4.2</td>
<td>Appointments and Events</td>
<td>56</td>
</tr>
<tr>
<td>4.4.3</td>
<td>Create Calendar Entries</td>
<td>56</td>
</tr>
<tr>
<td>4.4.4</td>
<td>Edit Calendar Entries</td>
<td>58</td>
</tr>
<tr>
<td>4.4.5</td>
<td>Delete Calendar Entries</td>
<td>58</td>
</tr>
<tr>
<td>4.5</td>
<td>MESSAGE BOARD</td>
<td>59</td>
</tr>
<tr>
<td>4.5.1</td>
<td>Open Message Board</td>
<td>59</td>
</tr>
<tr>
<td>4.5.2</td>
<td>Archive Messages</td>
<td>59</td>
</tr>
<tr>
<td>4.5.3</td>
<td>Delete Messages</td>
<td>60</td>
</tr>
<tr>
<td>4.6</td>
<td>PERSONAL NOTES</td>
<td>61</td>
</tr>
<tr>
<td>4.6.1</td>
<td>Open Personal Notes</td>
<td>61</td>
</tr>
<tr>
<td>5.1</td>
<td>CASE LIST</td>
<td>62</td>
</tr>
<tr>
<td>5.2</td>
<td>WORKFLOWS</td>
<td>63</td>
</tr>
<tr>
<td>5.2.1</td>
<td>Introducing Workflows</td>
<td>63</td>
</tr>
<tr>
<td>5.2.2</td>
<td>Using the Workflow Engine</td>
<td>64</td>
</tr>
<tr>
<td>5.3</td>
<td>CASE TRIGGERS</td>
<td>68</td>
</tr>
<tr>
<td>5.3.1</td>
<td>Case Trigger List</td>
<td>69</td>
</tr>
<tr>
<td>5.3.2</td>
<td>Create Case Trigger</td>
<td>69</td>
</tr>
<tr>
<td>5.4</td>
<td>CREATE CASE FILE</td>
<td>75</td>
</tr>
<tr>
<td>5.5</td>
<td>ELECTRONIC CASE FILE</td>
<td>76</td>
</tr>
<tr>
<td>5.5.1</td>
<td>The Object Browser</td>
<td>76</td>
</tr>
<tr>
<td>5.5.2</td>
<td>The Case File Directory</td>
<td>77</td>
</tr>
<tr>
<td>5.5.3</td>
<td>Case File Security Level</td>
<td>77</td>
</tr>
<tr>
<td>5.5.4</td>
<td>Case Properties</td>
<td>80</td>
</tr>
<tr>
<td>5.5.5</td>
<td>Open / Edit Case Object</td>
<td>82</td>
</tr>
<tr>
<td>5.5.6</td>
<td>Define Object Label and Content Type</td>
<td>82</td>
</tr>
<tr>
<td>5.5.7</td>
<td>Add Case Object to Calendar</td>
<td>83</td>
</tr>
<tr>
<td>5.5.8</td>
<td>Assign Case Object as Task</td>
<td>83</td>
</tr>
<tr>
<td>5.5.9</td>
<td>Content Validity</td>
<td>84</td>
</tr>
<tr>
<td>5.5.10</td>
<td>Link Case Objects</td>
<td>85</td>
</tr>
<tr>
<td>5.5.11</td>
<td>Copy Case File Object as Link</td>
<td>87</td>
</tr>
<tr>
<td>5.5.12</td>
<td>Migrate Case File Object to Central Repository</td>
<td>88</td>
</tr>
<tr>
<td>5.5.13</td>
<td>Make Local to Case File</td>
<td>88</td>
</tr>
<tr>
<td>5.5.14</td>
<td>Share Object</td>
<td>88</td>
</tr>
<tr>
<td>5.5.15</td>
<td>Copy Case File</td>
<td>90</td>
</tr>
<tr>
<td>5.5.16</td>
<td>Print Case File Object</td>
<td>91</td>
</tr>
<tr>
<td>5.5.17</td>
<td>Delete Case File Object</td>
<td>91</td>
</tr>
<tr>
<td>5.6</td>
<td>CASE DATA AND OBJECT TYPES</td>
<td>92</td>
</tr>
<tr>
<td>5.6.1</td>
<td>Case Details</td>
<td>93</td>
</tr>
<tr>
<td>5.6.2</td>
<td>Associated Reports</td>
<td>94</td>
</tr>
<tr>
<td>5.6.3</td>
<td>Object Persons / Individuals</td>
<td>95</td>
</tr>
<tr>
<td>5.6.4</td>
<td>Object Organization</td>
<td>98</td>
</tr>
<tr>
<td>5.6.5</td>
<td>Object Documents</td>
<td>99</td>
</tr>
<tr>
<td>5.6.6</td>
<td>Object Multimedia</td>
<td>104</td>
</tr>
<tr>
<td>5.6.7</td>
<td>Object Exhibits</td>
<td>105</td>
</tr>
<tr>
<td>5.6.8</td>
<td>Object Events</td>
<td>107</td>
</tr>
<tr>
<td>5.6.9</td>
<td>Object Notes</td>
<td>108</td>
</tr>
<tr>
<td>5.6.10</td>
<td>Object Bank Account</td>
<td>109</td>
</tr>
<tr>
<td>5.6.11</td>
<td>Object Tasking</td>
<td>110</td>
</tr>
<tr>
<td>5.6.12</td>
<td>Object Vehicle</td>
<td>113</td>
</tr>
<tr>
<td>5.6.13</td>
<td>Object Firearm</td>
<td>114</td>
</tr>
<tr>
<td>5.6.14</td>
<td>Object Phone</td>
<td>116</td>
</tr>
<tr>
<td>5.6.15</td>
<td>Object Property</td>
<td>116</td>
</tr>
<tr>
<td>5.6.16</td>
<td>Object Linked Cases</td>
<td>117</td>
</tr>
<tr>
<td>5.6.17</td>
<td>Object Diagrams</td>
<td>119</td>
</tr>
</tbody>
</table>
6 CENTRAL REPOSITORY .................................................................................................................. 148
6.1 MANAGING REPOSITORY OBJECTS .......................................................................................... 149
   6.1.1 Create Repository Object ......................................................................................................... 149
   6.1.2 Edit Repository Object ................................................................................................................. 150
7 SEARCH ................................................................................................................................................ 151
   7.1 GENERAL SEARCH ......................................................................................................................... 152
      7.1.1 Result Information ....................................................................................................................... 153
      7.1.2 Processing Results ....................................................................................................................... 154
   7.2 PERSON SEARCH ............................................................................................................................. 154
      7.2.1 Quick Search ............................................................................................................................... 155
      7.2.2 Advanced Search ......................................................................................................................... 156
      7.2.3 Comparison Types ....................................................................................................................... 157
      7.2.4 Result Information ....................................................................................................................... 157
   7.3 EXTERNAL SEARCH ....................................................................................................................... 157
      7.3.1 Load Data .................................................................................................................................... 157
8 SUSPECT INDEX ................................................................................................................................. 159
9 MY DIAGRAMS ..................................................................................................................................... 160
10 CONTENT MANAGEMENT .................................................................................................................. 162
   10.1 THE CARD VIEW ............................................................................................................................ 163
   10.2 THE GRID VIEW .............................................................................................................................. 163
   10.3 MANAGE CONTENT MANAGEMENT FOLDERS ......................................................................... 164
      10.3.1 Add Folder ................................................................................................................................. 164
      10.3.2 Edit Folder Properties and Security ............................................................................................ 164
      10.3.3 Delete Folder .............................................................................................................................. 165
   10.4 MANAGE CONTENT MANAGEMENT FILES ............................................................................. 166
      10.4.1 Add a Single File ......................................................................................................................... 166
      10.4.2 Add Multiple Files ...................................................................................................................... 166
      10.4.3 Edit File Properties ..................................................................................................................... 167
      10.4.4 Set File Security Settings ......................................................................................................... 168
      10.4.5 View File .................................................................................................................................... 168
      10.4.6 Delete Files .................................................................................................................................. 168
      10.4.7 Upload to Case File ..................................................................................................................... 168
   10.5 SEARCH CONTENT MANAGEMENT SYSTEM .......................................................................... 170
11 PHOTO MONTAGE .............................................................................................................................. 171
12 SPECIAL LISTS ................................................................................................................................. 173
13 EXHIBIT REGISTRY ............................................................................................................................ 174
   13.1 SEARCH EXHIBITS ......................................................................................................................... 174
   13.2 ADD MOVEMENT TO EXHIBIT ................................................................................................. 175
14 REPORTS ............................................................................................................................................... 177
   14.1.1 Run Report ................................................................................................................................. 177
   14.1.2 Launch Report ............................................................................................................................. 178
   14.1.3 Set Report Parameters ............................................................................................................... 178
   14.1.4 Retrieve result data: ................................................................................................................... 179
   14.1.5 Result Views ............................................................................................................................... 179
   14.1.6 General Report Processing Functions ......................................................................................... 180
   14.2 REPORT CHARTS .......................................................................................................................... 181
   14.3 REPORTS OVERVIEW .................................................................................................................. 183
      14.3.1 Table Statistics ......................................................................................................................... 184
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.3.2</td>
<td>User Activities</td>
</tr>
<tr>
<td>14.3.3</td>
<td>Case File Access Log</td>
</tr>
<tr>
<td>14.3.4</td>
<td>Object Creation Log</td>
</tr>
<tr>
<td>14.3.5</td>
<td>Cases, Sites, Status</td>
</tr>
<tr>
<td>14.3.6</td>
<td>Operations</td>
</tr>
<tr>
<td>14.3.7</td>
<td>Performance</td>
</tr>
<tr>
<td>14.3.8</td>
<td>Person Profile</td>
</tr>
<tr>
<td>14.3.9</td>
<td>Case Action Diary</td>
</tr>
<tr>
<td>14.3.10</td>
<td>Person Index</td>
</tr>
<tr>
<td>14.3.11</td>
<td>Case Action Diary</td>
</tr>
<tr>
<td>14.3.12</td>
<td>Crime Diary</td>
</tr>
<tr>
<td>14.3.13</td>
<td>CR Persons</td>
</tr>
<tr>
<td>14.3.14</td>
<td>Objects Catalogue</td>
</tr>
<tr>
<td>14.3.15</td>
<td>Social Network</td>
</tr>
<tr>
<td>14.3.16</td>
<td>Connected Objects</td>
</tr>
<tr>
<td>14.3.17</td>
<td>Resources</td>
</tr>
<tr>
<td>14.3.18</td>
<td>Ongoing Investigations</td>
</tr>
<tr>
<td>14.3.19</td>
<td>Case by Handlers</td>
</tr>
<tr>
<td>14.3.20</td>
<td>Status by Region</td>
</tr>
<tr>
<td>14.3.21</td>
<td>Case Statistics</td>
</tr>
<tr>
<td>14.3.22</td>
<td>My Events</td>
</tr>
<tr>
<td>14.3.23</td>
<td>Workflow Log</td>
</tr>
<tr>
<td>14.3.24</td>
<td>Cases I have worked on</td>
</tr>
<tr>
<td>14.3.25</td>
<td>Case by Offence</td>
</tr>
<tr>
<td>14.3.26</td>
<td>Case Reception Log</td>
</tr>
<tr>
<td>14.3.27</td>
<td>Financial Impact</td>
</tr>
<tr>
<td>14.3.28</td>
<td>Person Count by Age</td>
</tr>
<tr>
<td>14.3.29</td>
<td>Yearly Distribution</td>
</tr>
<tr>
<td>14.3.30</td>
<td>Yearly Distribution by Status</td>
</tr>
<tr>
<td>14.3.31</td>
<td>Cases by Clients</td>
</tr>
<tr>
<td>14.3.32</td>
<td>Case by Status</td>
</tr>
<tr>
<td>14.3.33</td>
<td>Workflow Actions</td>
</tr>
<tr>
<td>14.3.34</td>
<td>Workflow Transition Statistics</td>
</tr>
</tbody>
</table>
1 Getting Started

1.1 Login to goCASE

Start the application either via the Windows Start menu (Programs > goCASE) or by double-clicking on the goCASE icon () on your desktop. The login window appears:

![Login Window](image)

You can select the type of authentication that you want to enable on login under System Administration > Application Settings. You can either use goCASE or an Active Directory user as an authentication method. Enter your User Name and Password into the respective fields (both entries are case sensitive).

When launching goCASE for the first time (or if the database server has changed since you last logged in), enter the Server and Database information as provided by your goCASE or system administrator.

Confirm with Login. The goCASE application window is launched.

*Note: If you do not remember your user name or password, contact your goCASE administrator.*
Like many other desktop applications, the application window contains the following functional elements:

**Main menu:** Provides access to all goCASE functions (see section 2.1: The Main Menu).

**Toolbar:** A collection of icons for activating common functions (see section 2.2: The Toolbar).

**Quick-access bar:** One-click access to useful goCASE tools (see section 2.3: The Quick-Access Bar).

**Status bar:** Information about the current working context (see section 2.4: The Status Bar).

**Context menu:** Available processing functions for the selected content (see section 2.5: The Context Menu).

**Working area:** The main area of the user interface where the functional tabs are arranged when called and opened (see section 2.6: The Working Area).
2.1 The Main Menu

The goCASE main menu consists of the following items:

```plaintext
File  Edit  Components  Data  Tools  System Admin  Windows  Help
```

Each menu item contains a number of sub-menu items; some of which trigger functions and others which are split into submenus (indicated by ▶), providing even more functionality.

**Note:** The System Admin menu is only available to goCASE users with administration rights; its functionality is covered in a separate document. Access rights to the main menu differ depending on the permissions granted by the goCASE administrator.

You can activate a function in two ways:

1. **Mouse-click:** Click on a menu label; its menu items unfold. Select a menu item by clicking on it or expand a submenu (▶) by hovering with the mouse pointer over the submenu name and select an item from there by clicking on it.
2. **Accelerators:** The underlined letter of a menu label is called the accelerator. Hold the <Alt> key down and hit the accelerator key on the keyboard to expand the menu or trigger the function.

**Example:**
Hold <Alt> down and hit T, followed by U, to trigger the “user preferences” function. Release <Alt> afterwards.

**Note:** Not all menu items have accelerators.

2.2 The Toolbar

In the standard set-up, the toolbar is located directly below the main menu (see section 2.1: The Main Menu). It contains a collection of icons that trigger general goCASE functions, i.e. functions that are useful in many different situations, such as printing or exporting a particular set of data:

![Toolbar Icons]

Coloured icons (🖌️) mean that you can execute the function immediately. Impressed icons (coloured background: 🎨) indicate functions that are currently in use. Greyscale icons (⋯) are functions that are deactivated (not usable) in the current working context.

**Example:**
When editable data is shown in a goCASE window, then the “Save” function is active. If no data can be seen (e.g. immediately after the start-up), then the icon is deactivated. As soon as you click on an icon and a dialogue window appears, the icon becomes “impressed”.

**Note:** See section 3: General Functions for details about the different functions.

2.3 The Quick-Access Bar

The quick-access bar is located near the bottom and on the right-hand side of the application window. In the default configuration, it contains the modules **Notes Clipboard** and **Reports** (compressed view below):

![Quick-Access Bar Icons]
1. To open one of these tools, click on the chosen item in the quick-access bar. The window of the tool unfolds into the working area.
2. Click into some other area of the goCASE window to close the window again.
3. Click on the pin icon (＝) in the top right corner to fix the tool (hold it open permanently).
4. Click on the pin again (ɐ), to remove the fixation and make the tool foldable again.

Note: See section 3: General Functions for details about the different tools.

2.4 The Status Bar

The goCASE status bar is located at the bottom of the application window and contains useful information about the current working status:

In the bottom right corner, you see the name of the site you are working at, the goCASE server you are connected to and the username you are logged in with. The bottom left corner usually shows the most recent working status information.

2.5 The Context Menu

The context menu is a quick way of accessing context-specific functions no matter where you are currently working in goCASE. By default, the context menu is hidden from view.

1. Right-click into the area or on the piece of information where you want to do something. The context menu appears:

Click on a menu item to trigger the respective function.

Example:
The above example shows the context menu of a data grid or table (left) and a simple text field (right).
The User Interface

Note: Not all goCASE views provide a context menu. The different context menu functions are described in their working context. Refer to the respective chapters for details.

2.6 The Working Area

The goCASE working area occupies the largest part of the application window. Its main purpose is to hold input functions and to display various kinds of data. The basic layout of the working area is a collection of different functional panels; other functions are arranged in tabs.

Example:

In the above example, four tabs are open in the working area: The default start-up tab, the general search function, the contacts view (all three hidden) and person search (visible).

Note that the person search file in turn also has a number of different functional panels such as “Filter Parameters” and “Search Results”.

1. Click on a tab header to bring its content to the front.

Use the key combination <Ctrl>+<Tab> to leaf through the open tabs from left to right and <Ctrl>+<Shift>+<Tab> for the opposite direction.

Click on “close tab” (×) of any tab or hit <Ctrl>+F4 for the active tab to close it.

2.6.1 The Start-Up Working Area

The start-up tab of the working area is the default view. It offers the following functional panels:
Menu: Quick links to the main goCASE components (see section 3.4: Menu).

Personal Workspace: Links to user-specific information (see section 4: Personal Workspace).

Case File Browser: Quick access to the case files (see section 3.5: My Action Sheet – Open Case File).

Message Board: A list of messages from the system or other users (see section 3.6: Message Board).

Personal Notes: A list of personal notes either created by yourself or a fellow user (see section 3.7: Personal Notes).
3 General Functions

goCASE comes with a number of common features that can be applied to most of the forms and grids. There are several other useful tools that can be accessed from the quick-access bar (see section 2.3: The Quick-Access Bar). This section covers their usage and provides typical examples where necessary.

3.1 Keyboard Shortcuts

The following keyboard shortcuts can be used to trigger goCASE functions directly:

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Help</td>
</tr>
<tr>
<td>Ctrl+F4</td>
<td>Close current form</td>
</tr>
<tr>
<td>Ctrl+Shift+F4</td>
<td>Close all forms</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Select all</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy selected</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>Manage case triggers</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Open case file</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Print</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Paste</td>
</tr>
<tr>
<td>Ctrl+Shift+S</td>
<td>Save all forms</td>
</tr>
<tr>
<td>Ctrl+Tab</td>
<td>Switch to the next tab to the right</td>
</tr>
<tr>
<td>Ctrl+Shift+Tab</td>
<td>Switch to the next tab to the left</td>
</tr>
<tr>
<td>Alt+F4</td>
<td>Exit goCASE</td>
</tr>
</tbody>
</table>
3.2 Data Fields

In goCASE, different types of data fields are used. They fall into the two main categories input fields and selection fields.

3.2.1 Text Field

Text fields are the most common field type in goCASE. They are used to enter arbitrary text, numbers and special characters. Most text fields have no limitations in comparison to other types of fields which may require a certain type of input (e.g. all numbers, not more than 20 characters etc.):

![First Name:](image)

3.2.2 Date Field

Date fields accept only correct dates (in the form DD/MM/YYYY). They are equipped with drop-down calendars to easily facilitate input and to limit the possibility of errors.

1. Click on the day, month or year to edit the value manually or
2. Click on the drop-down icon (▼) beside the field. A date input helper appears:

![Date Field Helper](image)

i. Switch through the months and years using the arrow icons (◀ ▶).
ii. Click on the desired day.

3.2.3 Drop-Down Boxes

Some fields only accept a very limited scope of input. For instance, “Foreigner” can only be “Yes” or “No” (and “still undefined” as default). Another typical example is a country selection field, as there are only a limited number of countries. In such cases, drop-down boxes are used.

1. Click on the drop-down icon (▼) beside the field. The available options are shown:

![Drop-Down Box](image)

Click on an option to select it.

3.2.4 Checkbox

Checkboxes are decision fields for “Yes” and “No” decisions.
1. Click on the checkbox to activate it (✓) and opt for “Yes” or deactivate it (✓) by selecting “No”.

Example:
In the above example, the event information will be added to the diary of action.

3.2.5 Radio Button

Radio buttons are decision fields with a limited set of options (usually 2–7). In comparison with drop-down fields, radio buttons cannot have an “undefined” state; one option is defined as default. The difference to checkboxes is that the answers need not be “Yes” and “No”, but can be anything:

Click on an option to select it.

Note: Associated radio buttons can be arranged beside or below each other, but they are always grouped.
3.3 Grids / Tables

Grids (or data tables) play an important role in goCASE. They are the default way of presenting and formatting data such as report results. To make the most of the grids, goCASE tables come with a number of useful features for handling and manipulation:

Navigating: Browse the displayed data (see section 3.3.1: Navigate through Grids).
Sorting: Sort the data by a particular column (see section 3.3.2: Sort Data in Grids).
Appending and deleting rows: Add or remove rows in editable grids (see section 3.3.3: Append / Delete Grid Rows).
Customizing columns: Change the order of the columns in the grid; select which columns to display and which to hide or create hierarchical views through data grouping (see section 3.3.4: Customizing Grid Columns).
Filtering: Filter the visible content according to certain criteria (see section 3.3.5: Filtering Grid Data).

Note: Not all of these handling options are available in all grids; it depends on the content and working context.

3.3.1 Navigate through Grids

If a grid contains more data than the screen can display, then you can use the built-in features for leafing through the data sets. To facilitate this, the grid contains a navigation footer:

Click on ← or → to go to the previous or next data record.
Click on ↑ or ↓ to switch to the previous or next page of data records in the grid.
Click on # or # to jump to the first or last entry in the grid.

3.3.2 Sort Data in Grids

When goCASE data is displayed in grids, it is automatically sorted by some criterion defined in the goCASE set-up. If you want to change the sorting order:

1. Click into the column header of the column you want to use for sorting. The grid is sorted according to the contents of this column in ascending order (▲).
2. Click again into the header of the sorting column to reverse the sorting order to descending (▼) – and vice versa.

Sort Data via Context Menu:

1. Open the context menu of the column header (right-click):
Apply the desired sorting criteria:

i. Click on **Sort Ascending** to sort the contents of this column in ascending order (▲).

ii. Click on **Sort Descending** to sort the contents in descending order (▼).

iii. Click on **Clear Sorting** to re-apply the default sorting order.

### 3.3.3 Append / Delete Grid Rows

Grids that allow active data editing provide the option of removing rows from the grid; some also allow you to add new rows. In this case, the grid footer would look as follows:

1. To add a new row, click on **Add** (+) in the grid’s footer. An empty row is appended. Fill in the data as necessary for the function in question.
2. To delete a row, click into the row’s header to select it and click on **Delete** (−). The row is removed from the grid (sometimes following a mandatory security check).
3. You can cancel changes made to the current row in the grid by clicking **Esc**

**Note:** If the “Add” and “Delete” icons are available but inactive you might have to save the grid before being able to process it further.

### 3.3.4 Customizing Grid Columns

**goCASE** presents grids in a user-friendly way. However, certain users may wish to modify the view to suit their own needs. With **goCASE**, you can customize the grid columns as you like.

#### Adjusting the Column Width

If you want to change the width of columns:

1. Grab a column separator with the mouse and drag it to make the column to the left of it either wider or narrower.
2. Double-click on a column separator to apply the optimum width to the column to the left of it. The optimum width makes the longest entry in the column just about visible.
3. Open the context menu of a column header and select **Best Fit** to apply the optimum width to the selected column.
4. Open the context menu of a column header and select **Best Fit (all columns)** to apply the optimum width to all columns in the grid.
General Functions

Move Columns
To move a column from one position to another in succession:

1. Grab the column header with the mouse pointer, drag it into its new position and drop it there.

Add / Remove Columns
Not all grids show all columns by default. You may also wish to remove columns which are of no use to you to enhance clarity. To do this:

1. Open the context menu of a column header and select **Remove this Column** to hide the selected column.
2. To make hidden columns visible again or to hide multiple columns:
   i. Open the context menu of a column header and select **Column Chooser**. A **Customization** pop-up appears:

   ![Customization Pop-Up](image)

   **Note:** The pop-up window either contains a list of currently hidden columns or a usage hint.
   i. Drag-and-drop the columns you want to hide into the pop-up window.
   ii. Drag all columns you want to show again from the window and drop them into their new positions.
   iii. Close the window. The grid view is adjusted accordingly.

Grouping by Columns
By default, most grids are simply flat tables in which all entries are treated equally. However, it is possible to apply a more sophisticated view by grouping the content by certain columns. This creates hierarchical lists which allow you to expand or collapse data parts in the view according to your own needs.

**Note:** The grouping function is not available for all grids.

Tables that contain a grouping function are indicated by a **Group by** box located at the top of the grid:
3. If the Group by box is not visible in a grid, open the context menu of any column header and select Show Group by Box.

To group a grid by a column:

4. Drag and drop the column header into the Group by box. The contents are grouped by this column:

Example:
In the above image, the table was grouped by the column “Type of Case Trigger”.

To view the contents in this now hierarchical grid:

i. Click on Expand (_expand) to expand the group and show its contents:

iv. Click on Collapse (Collapse) to hide the data records of the group again.

v. Open the context menu of the Group by box and select Full Expand to expand all categories simultaneously.

vi. Open the context menu of the Group by box and select Full Collapse to collapse all categories simultaneously.

If you want to add a second category for sub-grouping, drag a second column header into the Group by box:
Example:
In the above image, the table was grouped by the column “Initial Case Type” and within this grouping by “Current status”.

2. Open the context menu of the Group by box and select Clear Grouping to remove all groups and show the flat table view again.
3. Open the context menu of either the “Group by” box or a column header and select Hide Group by Box to remove the box from view.

3.3.5 Filtering Grid Data

If you are looking for a specific type of data record in a grid, you can filter the view in the grid accordingly.

Example:
You have a list of case triggers and want to view those initiated through surveillance only, while ignoring others such as prosecution-based case triggers.

Quick Filter
To create a quick filter:

1. Hover with the mouse pointer over the column containing your intended filter criterion.
2. Click on the appearing “Filter” icon (✓). A list of all available categories in this column drops down:
   ![Dropdown menu](image)
   Click on the criterion you want to filter by. Any records which do not match that criterion are removed and the view in the grid is updated accordingly.

Remove Quick Filter
To remove the filter from a grid column:

1. Click on the “Filter” icon (✓) and select “All” from the drop-down list or:
2. Open the context menu of the column header and select Clear Filter.
Use the Filter Editor

If filtering by one column does not satisfy your purposes, goCASE provides you with a filter editor tool which you can use to design tailor-made filters for your data.

1. Open the context menu of a column header and select Filter Editor. The editor pops up:

   ![Filter Editor](image1)

   By default, the editor contains a “dummy” filter for the column used. The filter consists of three parts: The column, the condition and the value.

   **Example:**
   In the above example, the column is “From”, the condition is “Begins with” and the value is still undefined (“enter a value”).

2. Define a filter criterion as follows:
   i. Click on the condition and select the filtering condition (“equals”, “does not contain” etc.) from the drop-down list.
   ii. Click on “enter a value” and enter the desired value.
   iii. To change the column you are currently filtering, select the column name on the filter editor; this will display a drop-down list with all available columns. Select the desired column from the drop-down list.

   **Note:** The value field offers input support specific to the data type. For instance, if the data type is a plain text string, the value field is a simple input field; if it is a date, then the value field opens a date chooser and so on.

   If you want multiple filter criteria:
   i. Click on “Add new condition” (⊕). A second condition is appended.
   ii. Fill in the condition as described above:

   ![Filter Editor](image2)

   To remove a filter criterion, click on “Remove condition” (⊗).
3. Click on **Apply** to apply the filter to the grid or on **OK** to apply the filter and close the filter editor.

**Example:**
In the above example, we are looking for “old items which are still in draft state”; i.e. for dormant data which might need a clean-up.

4. The currently active filter is shown in the footer of the grid, together with an activated checkbox, indicating that the filter is active:

   ![Filter Example]

5. Uncheck the checkbox to deactivate the filter and show the full grid content again.
6. Click on **Edit filter** to modify the filtering criteria.
7. Click on “Remove filter” (×) to delete the filter.
3.4 Menu

The Menu panel in the goCASE Home tab is a collection of quick links to the main functions of the application. A typical menu panel of a person with broad permissions might look as follows:

1. Click on a link to trigger the respective function.

Note: Depending on your access permissions, the panel will contain a varying number of entries.
3.5  My Action Sheet – Open Case File

My Action Sheet is by default positioned in the top-centre area of the Home tab in the goCASE portal. It provides quick access to known case files:

The panel shows a list of recently used case files and an input field for known case identification numbers (CIN). Other case files can also be opened from here.

3.5.1  Open Last Accessed Case

To open one of the cases that you have recently used:

1. Click on the CIN of the case in the Last Accessed Cases list. The case file is loaded and displayed in a new tab.

3.5.2  Open Case using the Case Identification Number

If you know the CIN of the case you want to open:

1. Enter the case number into the field Case Identification Number.
2. Click Enter. The case file is loaded and displayed in a new tab.

3.5.3  Open any Case File

To open a case file that does not meet any of the above criteria:

1. Click on Search using other case attributes (button) in My Action Sheet OR select File ▶ Open case file from the menu. A selection dialogue window appears:
2. Select either of the radio buttons to choose whether you want to look for the case file by Case identification number, the Internal Case Reference, Case File Name or the Alternative File Name.

3. Enter the selected information into the respective field.

4. Click on OK. The case file is loaded and displayed in a new tab.

5. Look for a Case File by the Internal Reference Number by selecting the radio button.

6. It returns all the Case File(s) with the relevant Internal Case Reference.
3.6 Message Board

The message board is a list of all messages and tasks assigned to the user. These messages are delivered by the goCASE workflow engine; the system component that manages the flow of events and notifies the responsible users when tasks are to be acknowledged or completed. A message is sent when the security on the Case File has been changed or an object has been shared. The messages are stored in 2 different folders: Inbox and Archive.

The Message Board is denoted by the icon  and is located on the right-hand corner of the Dashboard. You can open the message board by directly clicking on this symbol or open it by clicking on Message Board under the Tools Menu. The number on the icon denotes that there are currently 17 unread messages in the Inbox of the message board.

**General functions:**

1. Click on an item in the **Message Boards** panel to show all messages within this message box.
2. Select a message in the **Message List** to view its details in the **Message Details** panel.
3. Click on **Refresh** button to look up and download the latest messages.
4. Click on a hyperlink in the **CIN** column to open the case associated with the message.
### 3.6.1 Archive Messages

To archive messages in the Inbox:

1. Select the message(s) from the **Inbox** by activating the relevant checkbox(s).
2. Click on **Archive Selected**. The messages are moved to the **Archive** message box.

### 3.6.2 Delete Messages

To delete messages from the message board:

1. Select the message(s) from the **Inbox** or **Archive** by activating the relevant checkbox(s).
2. Click on **Delete Selected**. The messages are deleted.

### The elements:

- **Status**: Shows whether the message is merely informative (empty). For workflow messages, if the user is the current transition owner, the message is indicated by (✔) or if the user was the transition owner but they have already been forwarded it, the message is indicated by (❑).
- **Priority**: The priority level of the case file this message is related to (low (L), normal (N) or high (H))
- **Date / Time**: The time stamp of the message.
- **From**: The sender of the message (either the goCASE system or another goCASE user).
- **Subject**: The subject or title of the message, indicating the contents.
- **Message from sender**: goCASE users can add a short personal note to any message they send.

### The functions:

1. Click on **Refresh** to check for new messages.
2. Double-click the notification to open the message in a new tab.
3. Click on a column header to sort the messages by that column.
General Functions

4. Click on Print (Printer icon) to print the list of messages.

Note: New and unopened notifications are highlighted in red. The number of messages in the box is indicated on the top of the Message Board.
3.7 Personal Notes

Personal notes can be sent between users or created for personal use via the **Notes Clipboard** (see section 3.8: Notes Clipboard). The Personal Notes icon is indicated by this icon ( ) in the top right-hand part of the dashboard.

<table>
<thead>
<tr>
<th>Note Subject</th>
<th>Created By</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ruby</td>
<td>Copy CARE Trainer</td>
<td>11 August, 2015 3:15 PM</td>
</tr>
<tr>
<td>Draft report Case PU 201</td>
<td>Patricia Olschner</td>
<td>17 June, 2015 1:51 PM</td>
</tr>
<tr>
<td>DRAFT L17 REPORT</td>
<td>Kyle Shrefford</td>
<td>17 June, 2015 1:50 PM</td>
</tr>
<tr>
<td>Forensic File</td>
<td>Mylene Sponza</td>
<td>17 June, 2015 1:50 PM</td>
</tr>
<tr>
<td>Personal message</td>
<td>Suzanne Schultz</td>
<td>17 June, 2015 1:50 PM</td>
</tr>
<tr>
<td>GE notes</td>
<td>Craig English</td>
<td>17 June, 2015 1:50 PM</td>
</tr>
</tbody>
</table>

**The elements:**
- **Note Subject:** The subject of the note.
- **Created by:** The author of the note.
- **Date:** The date on which the note was created.

**The functions:**
1. Click on **Refresh ( )** to check for new incoming personal notes.
2. Click on any of the row on the Personal Notes panel to display its details in the Notes Clipboard.
3. To delete a note, select it by clicking into its row header; then click on **Delete ( )** in the panel’s footer.
4. Following a security check, the personal note is deleted.
5. To Print any of the Personal Notes, right-click and select **Print Selected** option.
3.8 Notes Clipboard

The Notes Clipboard is used for creating notes within goCASE. You can either use it as a reminder for yourself or for sending work-related messages to other goCASE users.

1. Click on Notes Clipboard in the quick-access bar (see section 2.3: The Quick-Access Bar). The clipboard pops up:

By default, the clipboard shows the note currently selected in the Personal Notes window (see section 3.7: Personal Notes). You can create a different note here at any time.

The elements:
Subject: The subject of the note.
Text field: The content of the note
Buttons: The available functions.

3.8.1 Create Note

To create a new note:

1. Click on New Note. An empty note window appears:

2. Enter a self-explanatory subject into the Subject field.
3. Enter the note into the text field.

Note: You can format and process the text as you would with many word processors. You can use the spell-check for your note.

Save the note for future personal reference.
Send Note

To send the active note to another goCASE user:

1. Click on Send To. The Resource Selector appears:

2. Select the intended recipients in the Resource List and add them by clicking on Add ( ).
3. Confirm your selection with OK. The recipients are added and the note is sent to them.

Note: The Resource selector is a widely used tool in goCASE. See section 3.9: Resource Selector for handling details.

Print Note

To print the active note:

1. Click on Print ( ) in the clipboard. The operating system’s print dialogue window appears.
2. Send the message to any installed printer you like.

Delete Note

To delete a personal note from the clipboard:

1. Select the note in the Personal Notes panel.
2. Click on Delete. The note is deleted.
**Note:** You can dock the notes clipboard by clicking on so that the clipboard remains open so long as you want it to and you can close it again by clicking on this icon.
3.9 **Resource Selector**

The goCASE resource selector is used throughout the application.

The window provides a list of all available resources based on the selected type. The icon next to the name indicates whether it is a person or a group.

**Example:**
In the above screenshot, the required set resources are persons.

You can either select the necessary resource by name from the collection of all resources or you can create a list of personal favourites. If you want to select a resource by name, you can simply add it from the list of all resources or use the filter options provided.

### 3.9.1 Select Resource(s) manually

Select the resource from the **Resource List**:

1. Select a resource by clicking on it.
2. Select multiple resources using <Ctrl>+Click or <Shift>+Click (where the system allows it).
3. Select all available resources by clicking on **Select All**.
4. Click on “Add” ( ). The resources are added to the “Selected Resource” list.
5. Confirm your selection with **OK**.

### 3.9.2 Deselect Resources

To remove already selected resources:
1. Select one or more resources from the **Selected Resource** list as described above and click on Remove ( ).
2. Click on Remove all ( ) to empty the list with one click (no selection necessary).

The resources are removed from the list.

### 3.9.3 Filter Resources by Name

Sometimes resource lists can be very long. Hence you would like to filter the list before selecting your desired resources. One possibility is to filter the names of the resources:

1. Type part of the resource name into the field **Resource Name**. The list view is filtered to show only the resource names containing your input text.

   **Example:**
   If you enter “director” into the field when searching for persons, the list will only show names containing this string. The actual position within the name is irrelevant: Both “Managing Director” and “Director of Operations” will be returned as results.

### 3.9.4 Filter Resources by Sub-Type

Another possibility for filtering the resource list is to search (where possible) for a specific sub-type of the resource type (if this kind of resource has sub-types):

1. Select a sub-type from the drop-down list **Sub-type**. The **Resource List** is updated accordingly.

   **Example:**
   The person selector offers sub-type functional titles such as “Chairman”, “System Administrator” and “Investigation Officer”.

**Note:** You can use both the name and the sub-type filter at the same time.

### 3.9.5 Favourites

As a goCASE user, you would be using certain resources more frequently than others. For the sake of convenience, these resources can be aggregated in **Favourites** lists:
**General Functions**

_Note:_ Resources from favourites collections are selected and used in the same way as the other resources described above.

**Create Favourites List**

To create a new list for your favourites:

1. Enter the name of the new list into the field Favourites collection.
2. Click on Add ( ). A new, empty favourites list is added to the collection.

**Set Favourites List as Default**

To set one of the favourites lists as the default list:

1. Select the collection name from the drop-down list Favourites collection.
2. Click on Set default ( ). From now on, this list is your default list.

**Delete Favourites List**

To remove a favourites list:

1. Select the list name from the drop-down list Favourites collection.
2. Click on Delete ( ). Following a security check, the favourites list is deleted.

**Add Resources to Favourites**

To add one or more resources to one of your collections of favourites:

1. Select the collection title from the drop-down list Favourites collection.
2. Switch to the tab **Select by Name**.
3. Select your chosen resource from the **Resource List** as described above.
4. Click on **+ Favourites**. The resource is added to your active favourites collection.

**Note:** Individual resources can be added to as many collections as required.

**Remove Resources from Favourites Collection**

To remove one or more resources from a collection of favourites:

1. Select the name of the collection from the drop-down list **Favourites collection**. Its contents are displayed in the list box **Resource List**.
2. Select the resources you want to remove.
3. Click on **– Favourites**. The list items are removed from the collection.
3.10 Audit Trail

The audit trail function allows you to view the revision history of case and repository objects:

1. Open the object (person, organization etc.), you wish to investigate and set the focus to any data field within the object’s details screen.
2. Click on Audit Trail or select Data > Audit Trail from the menu. The Audit Trail window is displayed:

   ![Audit Trail Window](image)

   The dialogue window lets you know which user created the object, who the last user to modify it was and the timestamps of when it was created/modified etc.

3. Click on History details to view a detailed history of the changes.
4. The window is expanded and shows a list of all revisions, together with a list of all users who made changes (User Name), the type of change (Transaction Type), and the timestamp of the change (Date of Transaction and Time of Transaction). The version number (Sr.No.) shows the order of changes with “1” being the most recent one:
5. To compare two or more revisions, select the rows that you want to compare from the grid. The modification details of these versions are displayed in the bottom part of the dialogue window (showing the field names and the selected versions from old to new).
4 Personal Workspace

The top-right area of the goCASE Home portal provides access to user-specific information via hyperlinks indicated by icons.

A user’s personal workspace contains the following functions (click on the link to activate the function):

**My case list:** Cases related to the user and his/her work (see section 4.1: My Case List).

**User preferences:** Personal data and application settings (see section 4.2: User preferences).

**To do:** Personal and case tasks assigned to the user (see section 4.3: To Do).

**Calendar:** Allows the user to keep track of his/her application-related appointments (see section 4.4: Calendar).

**Message Board:** A list of all messages and tasks assigned to the user (see section 4.5: Message Board).

**Personal notes:** Notifications between users or reminders created for personal use (see section 4.6: Personal Notes).
4.1 My Case List

My Case List is a list of cases which are in some way related to the active user and includes:

- All cases assigned to the user in the workflow.
- All cases for which the user is Lead Investigator or Second Investigator
- All cases to which the user has explicitly been assigned in the access control list.

4.1.1 Open List

Choose one of the following actions:

1. Select Tools ▶ My Case List from the menu.
2. Click on My Case List icon
3. The list is opened and displayed in a new tab:

The elements:
- The top grid displays a list of all relevant cases together with some of the meta information (e.g. the status of the case).
- The bottom grid Resources to whom access has been granted displays all users who have access to the selected case, together with their current access status (access from/to or continuous).
- All the Super users to goCASE are also listed in the left-side of the lower grid.

Note: Case access can be granted either to user groups or to individual users.

The functions:
1. Click on Refresh (Refresh) to look for changes and refresh the list of cases.
2. Click on the Case Identification Number (CIN) hyperlink to open and show the respective case file.
4.2 User preferences

User preferences contain a number of basic settings for the user and the goCASE application. You can edit the user data and customize the application settings according to your needs.

4.2.1 Open User Preferences

Choose one of the following actions:

1. Select Tools ▶ User Preferences from the menu.

2. Click on User Preferences icon

The User Preferences are opened and displayed in a new tab:

![User Preferences](image)

The elements:

The user preferences are divided into six tabs:

- **Profile**: The user data of the active user (see section 4.2.2: User Profile).
- **Options**: Personal tool settings for the goCASE application (see section 4.2.3: User Options).
- **Change Password**: Change the password of the active user (see section 4.2.4: Change Password).
- **Delegation**: Delegate your workflow assignments to other persons (see section 4.2.5: Delegation).
- **Reporting Hierarchy**: Both the upwards and the downwards reporting hierarchy of the user is displayed in the top and the lower grids respectively.
- **Time Sheets**: Time Sheet displays dates in column format from Monday to Sunday. Time is indicated in 30 m slots. A user can select an Activity and a Case file.
4.2.2 User Profile

The user profile is part of the goCASE user preferences (see section 4.2: User preferences). It contains general user data such as name, email, phone number etc. and outlines the position of the user within the organization:

Profile Data

The user profile data can be categorized as follows:

**Personal data:** Title, name and photo.

**Business data:** Functional title, office rank, reporting officer.

**Working environment data:** Office information, email, and phone.

**Organizational data:** Organization group and reporting hierarchy.

*Note: You cannot modify your name or the organizational data.*

**The Functions:**

Adjust your personal, business and working environment data by clicking into the fields and entering or selecting the new information.

To upload a personal photo:

1. Open the context menu of the Resource Photo box and select Load. The operating system’s file chooser appears.
2. Select the image file and confirm your selection.

4.2.3 User Options

The Option tab contains several settings that the user can adjust according to his or her needs:
User Options

Select the language and culture you wish to apply to the goCASE user interface from the drop-down list **Application Default Language**.

**Note:** You have to restart goCASE to make these changes visible.

### General Options

**Last accessed cases:** Determine the number of last accessed cases to be displayed on the **Home** screen.
Startup message (days): Set how many messages (for the days in the past until now) you want to see on the Message Board on the Home screen.

No. of notes in Startup: Choose how many notes are to be displayed in the Personal Notes section on the Home screen.

Default Case Type: Select one of the available Case Types for creating a new case

Default Case Trigger Type: Select one of the available templates for creating a new case files or to start with a blank one (“<<Clear>>”).

Notification Settings

Notify when new object is added/deleted: If activated, goCASE sends a notification every time the number of objects in one of your cases change.

Send goCASE messages to my email: Activate if you wish to receive an email every time goCASE dispatches a notification.

Calendar Events

Select Calendar Entries and Events Objects check-boxes if you want to see these entries in the Calendar or in the Events Calendar.

4.2.4 Change Password

This tab allows active users to change their passwords at any time:

```
<table>
<thead>
<tr>
<th>User Profile</th>
<th>User Options</th>
<th>Change Password</th>
<th>Delegation</th>
<th>Reporting Hierarchy</th>
<th>Time Sheet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Password:*</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Password:*</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Confirm New Password:*</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Apply
```

1. Enter your old password into the field Current password.
2. Enter the new password into the fields New password and Confirm new password.
3. Click on Apply. The password is changed and the new one activated from the next login.

Note: The new password must be between 6 and 15 characters long and contain at least one lower case and one upper case letter.

4.2.5 Delegation

Delegation function allows you to delegate your workflow transitions to other users:
The elements:

**Workflow cycle:** The drop-down list contains a list of workflow cycles to which you, or your organizational group, have access and activity rights.

**Regular/optional transitions:** The regular and optional transitions in the selected workflow.

**Delegated to me:** This tab shows all delegations made to you by other people.

**Delegate Transition**

To delegate a transition to another user:

1. Select the workflow with the chosen transition from the drop-down list **Workflow cycle.** The transitions are displayed.
2. Click into the field of the transition in question. The Resource Selector pops up:
3. Select the user or group you want to delegate the transition to (see section 3.9: Resource Selector) for handling details and confirm with OK.

4. Determine the duration of the delegation:
   
i. For an indefinite delegation, check the checkbox Never Expires.
   
ii. For a limited delegation, click into the field Effective Date and select the start date of the delegation, then click into the field End Date and select the chosen expiration date.
   
iii. Activate the checkbox Keep Me Informed if you wish to receive notifications for all actions taken on your behalf.
   
iv. The delegation details appear under 2 different types: Delegate to and Delegated To Me
4.2.6 Reporting Hierarchy

Both the upward and the downward hierarchy of the user is displayed in the upper and lower grid respectively.
4.2.7 Time Sheet

Time Sheet has under User Preferences displays dates in column format from Monday to Sunday. There is a tooltip to indicate the date on the column header. By default the current week is displayed but the user can move back or forward using the buttons. Time is indicated in 30 m slots. A user can select an Activity and a Case file. It does not allow duplicate entries for a week. Once the user has entered information in a row and it has updated the DB it is no longer possible to change the Activity or the CIN. The user will have to delete a row if they want to change the Activity or CIN number else create a new row and set all the values to 0 in the previous row.
### Case Management

#### Time Sheet

<table>
<thead>
<tr>
<th>Activity</th>
<th>CNTR</th>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
<th>Friday</th>
<th>Saturday</th>
<th>Sunday</th>
<th>Total for Week</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post-investigative</td>
<td>0034-VE-15-003365</td>
<td>0.5</td>
<td>4.5</td>
<td>0</td>
<td>0</td>
<td>4.5</td>
<td>0</td>
<td>0</td>
<td>9.00</td>
</tr>
<tr>
<td>Administration</td>
<td>0034-VE-15-003367</td>
<td>0.5</td>
<td>4.0</td>
<td>0</td>
<td>0</td>
<td>0.5</td>
<td>0</td>
<td>0</td>
<td>4.50</td>
</tr>
</tbody>
</table>

**Record 1 of 2**
4.3 To Do

The **To Do** component helps you manage tasks. This includes your own tasks as well as those assigned to you by other users.

4.3.1 Open To Do component

Choose one of the following actions:

1. Select **Tools ▶ To Do** from the menu.
2. Click on **To Do** icon in the **Personal Workspace** panel of the **Home** tab (see section 4: **Personal Workspace**).
3. The **To-Do** task list is opened and displayed in a new tab:

![To Do component](image)

The panel on the left-hand side displays the available task categories. The top panel outlines the main functions while the grid shows all tasks in the active category. The categories are:

- **All tasks**: All tasks which includes case tasks, personal tasks and all completed tasks.
- **Case tasks**: Tasks created within a case file and not yet completed. Case tasks cannot be added to the to-do component.
- **Personal tasks**: Tasks added to the to-do component and not linked to any specific case file. Only visible to the user who originally created the task and to those who have been specifically assigned to the task.
- **Completed tasks**: All case and personal tasks marked as completed.

**General Functions**

1. Click on a category in the **Task Menu** to display all tasks within this category.
2. Click on **Refresh** to check for new tasks and to update the whole view.
3. Click on a case task’s **Subject** hyperlink to jump to the case file and the case object this task was created for.
4. Click on a personal task’s **Subject** hyperlink to show the task’s content and details.

**Processing Functions**

1. To mark a task as being currently processed, select it by activating its checkboxes and click on **In Progress**. The **Status** of the selected task is updated accordingly.
2. To mark a task as being completed, select it and click on **Completed**.
3. The **Status** of the tasks is updated accordingly and the entries are moved to the **Completed tasks** view.
4. Click on Cancel to uncheck all checkboxes with one click.
5. To remove a task from the to-do list, select it and click on **Cancel**. The task is deleted.
6. To delete a task from the to-do list, select it and click on **Delete**.

**Note:** If an already “completed” task is reverted to “in progress”, then the task is moved out of the “completed” view into its original category.

### 4.3.2 Create Task

To create a new personal task:

1. Click on **Add Task**. An empty **Task Details** window pops up:

```
Subject:*  
Due By:*  
Start By:*  
Category: << Clear >>  
Priority: << Clear >>  
Assigned By:  
Task Description:  
Task Outcome:  

Assign Task: 

<table>
<thead>
<tr>
<th>Resource Name</th>
<th>Required</th>
<th>Completion Status</th>
</tr>
</thead>
</table>
```

2. Enter the task’s **Subject** as well as its **Due by** and **Start by** dates.

**Note:** All fields marked with an asterisk are mandatory. You must enter this information before you can add resources.

3. Select a **Category** and a **Priority** from the drop-down lists.
4. Enter a **Task description** and a **Task outcome** into the text fields. You can apply basic formatting to the text.
Assign the task:

1. Activate the checkbox **Assign to myself** if you want to assign the task to yourself. Otherwise, deactivate it.
2. Click on **Append (•)*** in the resource grid’s footer. The **Resource Selector** appears:

![Resource Selector](image)

3. Select the users or groups you want to add to the task (see section 3.9: **Resource Selector** for handling details) and confirm with **OK**.
4. Click on **Save**. The personal task is created and sent to all assigned users.
5. Close the **Task Details** window when finished.

### 4.3.3 Edit Task

To edit a personal task:

1. Select the **Personal Tasks** view from the **Task Menu**.
2. Click on the **Subject** hyperlink of the task you want to edit. The task is loaded and displayed:
3. Adjust the **Task Details** as necessary.
4. Assign the task to more people as described above.
5. Revoke assignments by selecting the person or group in question and clicking on **Delete** in the grid’s footer.
6. Click on **Mark As Complete** once you have finished a task. The task status is adjusted accordingly.
7. **Save** your changes and close the dialogue window.
**Case Management**

**Task Details**
- **Subject:** Meet with the Lead Investigator of the Case
- **Due By:** 17/09/2015
- **Category:**

**Task Description:**
1. Click on **Mark As Complete** once you have finished a task. The task status is adjusted accordingly.
2. Save your changes and close the dialogue window.

**Task Outcome:**
- Adjust the **Task Details** as necessary.
- Assign the task to more people as described above.
- Revise assignments by selecting the person or group in question and clicking on **Delete (X)** in the grid’s footer.

**Assign Task**
- Staff Member Name: goCASE Trainer
  - Required: Required
  - Completion Status: Not Started
4.4 Calendar

The goCASE calendar keeps track of your application-related appointments, including entries made in case objects as well as events created in the Event object of a case or repository file. You can also create appointments and events directly in the calendar.

Note: All appointments added to the goCASE calendar are displayed in the event list on the start-up tab.

4.4.1 Open Calendar

1. Choose one of the following actions:
2. Select Tools ▶ Calendar from the menu.
3. Click on Calendar icon in the Dashboard. The calendar is opened and displayed in a new tab:

The calendar consists of an overview panel (right) and a details view (left). Dates outlined in bold in the overview indicate calendar entries for those days.

General Functions

4. Click on a week number in the overview panel to display this week in the details view.
5. Click on a day in the overview panel to display that day in the details view.
6. Click on Previous Appointment or Next Appointment to browse through your appointments.
7. Click on Today or open the context-menu of the details view and select Go to today to jump to today’s calendar slot.
8. Open the context-menu of the details view and select **Change View to ➤ <any>** to change the view on the calendar details (day, work week…).

9. Open the context-menu of a specific day in the details view and select **Go to this day** to open the daily view of this day.

### 4.4.2 Appointments and Events

#### Create calendar entries:
Create new appointments and events (see section 4.4.3: **Create Calendar Entries**).

**Edit calendar entries:** Edit existing calendar entries (see section 4.4.4).

**Delete calendar entries:** Remove entries from the calendar (see section 4.4.5).

#### 4.4.3 Create Calendar Entries

You can create the following types of calendar entries:

- Appointments
- Recurring appointments
- All-day events
- Recurring events

**Create Appointment**

1. Open the context-menu of the calendar details and select **New Appointment**. An input window pops up:

2. Enter a **Subject**, **Location** and **Type** (optional) for the new appointment.
3. Enter a date and time schedule and decide whether you want to set a **Reminder**.
4. Enter a description of the appointment into the large text field.
5. Select the persons or groups you want to invite to the appointment by clicking on **Append** (functions) in the footer of the resource grid.
6. The **Staff Selector** appears (see section 3.9: **Resource Selector** for details on the selector).
7. If the appointment is recurring, click on **Recurrence**. The **Appointment Recurrence** window pops up:
8. Check the **Appointment time**, define the **Recurrence pattern** (daily, weekly…) and the **Range of recurrence** (start/end dates); then confirm your selection with **OK**. The recurrence window closes.

9. Confirm with **OK**. The appointment is added to the calendar.

**Create Recurring Appointment**

To create a recurring appointment, choose one of the following actions:

1. Create an appointment and add the recurrence information as described above.
2. Open the context-menu of the calendar details and select **New Recurring Appointment**. The input window pops up with the recurrence information input already available.

Then proceed as described above.

**Create All-Day Event**

To create a new all-day event, choose one of the following actions:

1. Create an appointment and activate the checkbox **All-day Event**.
2. Open the context menu of the calendar details and select **New All-day Event**.
3. The input window pops up with the checkbox already activated.

Then proceed as described above.

**Create Recurring All-Day Event**

To create a new recurring all-day event, choose one of the following actions:

1. Create an appointment, activate the checkbox **All-day Event** and add the recurrence information as described above.
2. Open the context- menu of the calendar details and select **New Recurring Event**. The input window pops up with the recurrence information input already available and the checkbox already activated.

Then proceed as described above.
4.4.4 Edit Calendar Entries

To edit an existing calendar entry:

1. Double-click the entry in the calendar details panel. The entry opens in a pop-up window.
2. Edit the settings according to your needs (see section 4.4.3: Create Calendar Entries for details).
3. Click on OK to confirm the changes.

4.4.5 Delete Calendar Entries

To delete an existing calendar appointment or event, choose one of the following actions:

1. Open the context menu of the calendar entry and select Delete.
2. Double-click the entry to open it and click on Delete.

The entry is removed from the calendar.
4.5 Message Board

The message board is a list of all messages and tasks assigned to the user. These messages are delivered by the goCASE workflow engine, a system component that manages the flow of events and notifies the responsible users when tasks are to be acknowledged or completed.

4.5.1 Open Message Board

Choose one of the following actions:

1. Select Tools ▶ Message Board from the menu.
2. Click on Message Board icon in the top-right corner of the dashboard

The message board is opened and displayed in a new tab:

The left panel in the tab shows the names of the various message boxes. The top panel lists the messages in the active box (unread messages are highlighted in red) while the bottom panel displays the details of the message currently selected in the top panel.

**General functions:**

5. Click on an item in the Message Boards panel to show all messages within this message box.
6. Select a message in the Message List to view its details in the Message Details panel.
7. Click on Refresh button to look up and download the latest messages.
8. Click on a hyperlink in the CIN column to open the case associated with the message.

4.5.2 Archive Messages

To archive messages in the Inbox:

4. Select the message(s) from the Inbox by activating the relevant checkbox(es).
5. Click on Archive Selected. The messages are moved to the Archive message box.

### 4.5.3 Delete Messages

To delete messages from the message board:

6. Select the message(s) from the Inbox or Archive by activating the relevant checkbox(es).
7. Click on Delete Selected. The messages are deleted.
4.6 Personal Notes

Personal notes can be sent between users or created for personal use via the Notes Clipboard (see section 3.8: Notes Clipboard).

Note: You can also access personal notes directly from the Home tab (see section 3.7: Personal Notes).

4.6.1 Open Personal Notes

Choose one of the following actions:

1. Select Tools ▶ Personal Notes from the menu.
2. Click on Personal Notes icon in the Dashboard
3. The Notes module is opened and displayed in a new tab:

   ![Notes Module](image)

   The top panel lists the notes in the active box while the bottom panel shows the details of the note selected from the top panel.

   **The functions:**

   1. Click on an item in the Notes Boards panel to show all notes within this notes box.
   2. Select a note from the Note Actions list to display its details in the Notes Details panel.
   3. Click on Refresh (Refresh) to check for new incoming personal notes.
   4. Select notes by activating the relevant checkboxes and click on Delete Selected to delete obsolete notes.
   5. Select notes by activating the relevant checkboxes and click on Archive Selected to archive notes.
5 Case Management

Managing cases is the core functionality of goCASE. The following chapters will outline the available features in this module and will demonstrate how best to work with goCASE to manage cases effectively.

5.1 Case List

The goCASE case list displays all cases to which the active user has access to. For more effective handling, they are organized according to the case type. To view the case list:

1. Click on Case List icon in the left-hand menu on the dashboard OR select Components ➤ Case List from the menu. The case list is loaded and displayed in a new tab:

The case file information is shown in a tab with two panels. The left panel shows a tree list with all available case types in alphabetical order: Intelligence, Prosecution etc. The number in brackets indicates the number of stored cases of the respective type.

The right-hand panel consists of a grid with all cases from the category currently selected in the tree list and for which you have access permissions.

1. Select a case category from the tree list to display all cases within that category (or “all” to show all cases).
2. Expand (⊙) a category and select a sub-category to show only the cases in a particular state (e.g. “draft”) of that category.
3. Click on Refresh (↻) to update the current list of cases.
4. Click on the CIN (case identification number) link of a case to load and display the respective case file.
5. You can also filter the cases by Originating Site by selecting the specific office from the drop-down menu.
5.2 Workflows

The goCASE workflow engine is a built-in component in goCASE which drives the case life cycle. All transitions and activities driving the standard business procedures are controlled and audited by the workflow component. This section covers the following topics:

**Introduction:** an overview of goCASE workflows and their capabilities (see section 5.2.1: Introducing Workflows).

**Usage:** The workflow engine on the goCASE user interface and how to work with it (see section 5.2.2: Using the Workflow Engine).

### 5.2.1 Introducing Workflows

The goCASE workflow can be roughly outlined as follows:

1. Any petition submitted to the organization, regardless of whether it arrives by post, email or messenger, is registered as a **Case Trigger** and a unique **Case Identification Number (CIN)** is automatically assigned as the primary reference number.

2. In line with the workflow, the new trigger may then be reviewed by the organization’s Head of Operations. It may then be forwarded to a team of specialists tasked with carrying out a detailed investigation of the case trigger.

3. In accordance with the workflow definition, the case trigger is transformed into a **Case File** which contains more detailed object categories and attributes for supporting thorough the investigation. The person to whom the case file is assigned becomes the **Case First Officer**.

4. The **Case First Officer** manages the access levels and user permissions for the case file.

**Example:**

A case can e.g. be set to “blind”, so that only the explicitly assigned users can search, view and edit data directly associated with the case.

Closing a case file sets the case to “read-only” and no further modifications are possible in this state. However, reopening case files is also supported.

Depending on the business needs, the workflow can hold as many transitions as required. Each transition reflects a distinct responsible unit or person and a specific task to be executed. Workflows are usually defined right after the goCASE installation before productive work starts.

The **Case Details Form** displays the current status of the case and provides the option of transiting to the next possible workflow state (in accordance with the workflow definition and user permissions).

For all workflow transitions, the case permissions are updated automatically. The person currently “holding” the case file can access the data within the case file.

The workflow engine notifies users of the cases assigned to them. It also forwards any messages sent by the person assigning the case (see also section 3.6: Message Board).

Authorized users can override the regular flow by performing optional transitions or revert the procedure to any previous state of the case file. In such a specific case, the previous case file owner will be notified automatically.

### Sample Workflow

A typical workflow definition could look as follows:
5.2.2 Using the Workflow Engine

The goCASE workflow window can be opened by clicking on the workflow icon 🏷. This is available on the goCase Dashboard on My Action Sheet (left-most column) or on the Case Details form or on the Case Trigger form. Clicking on this icon opens the Workflow window.
It is possible to select and attach documents (pertaining to the Case File) to the workflow action as the Case File transitions to the next stage of the workflow. Click on the Attachment icon in the top-left corner of the workflow window. It opens up the Documents window.
In this window, select the documents, that you wish to attach to the Case workflow action and click on the Attach button. The documents to be attached appear in the right-panel of the workflow window.
Enter all the fields in this window and select the resource by clicking on to submit it to the relevant person for the next action.

You can enter your Recommendations/Comments if any in the Recommendations/Comments field.

To view the Workflow History log click on this icon.
Regular Flow

You can perform regular or optional transitions as required in the case. The regular flow is system-defined and will automatically follow the default route defined for the case file type.

Current status: The current state of the workflow and the user who set the case to this state. 
Since / Due date: Time stamps of when the case entered this state and when it is expected to proceed to the next state. 
Recommendations/Comments: Every stage of the workflow allows the user to add personal comments to the case or the workflow. 
To: The dedicated next user in the chain of events. Click on the … button to change this user manually. 
(The transition button): Click on the large button to move the case file to the next workflow stage. The label on the button indicates what this next stage will be. 
(The “revert” button): Click on the small button to revert the workflow to the previous state and reassign it to the previous person. In such a case you should always add a comment to make your decision clear. 
History: It displays all previous messages/instructions sent via the workflow. It shows the author, date and message. These messages are the same as the ones that appear in the message board as well as in the Workflow History Log report.

Options

The priority setting for the case is available in the right corner of the workflow window.

By default, the priority of a case is set to “normal”. To change this, move the slider to the new priority level.

5.3 Case Triggers

The Case Trigger is the entry point for initiating a new case. Its purpose is to capture and aggregate the initial information quickly and easily. The case triggers within the goCASE
database can be viewed in the **Case Trigger List** (see section 5.3.1: Case Trigger List). You can also create new case triggers whenever needed (see section 5.3.2: Create Case Trigger).

### 5.3.1 Case Trigger List

The **Case Trigger List** displays a list of case triggers the goCASE workflow engine has assigned to any particular user (see section 5.2: Workflows for details).

1. Click on Manage Case Triggers ( ) or select Components ➤ Manage Case Triggers form the menu. The list of case triggers is opened and displayed in a new tab:

   ![Case Trigger List](image)

   2. Select the person whose case triggers you want to see ( ). The **Case Triggers** list is updated accordingly.

   **Note:** The active user’s case triggers are shown by default.

   3. If you want to search for case triggers in a certain **Current Status**, filter the view by selecting this status from the drop-down list **Filter by status**.

**View Trigger Details**

To view the details of the Case Trigger, click on the CIN hyperlink on the Manage Case Triggers grid. It opens the Case Trigger with all relevant details, which are displayed in 3 different tabs: **Trigger Details**, **Trigger Persons** and **Trigger Organizations**.

**Note:** To view an enclosed file you must have the suitable application stored on your computer. For example, to open a Word file you need either Microsoft Word or Open Office.

### 5.3.2 Create Case Trigger

To add a new case trigger to the goCASE database:

1. Click on **Initiate New Case** in the **Case Trigger List** (see section 5.3.1: Case Trigger List for details). A new, empty case trigger sheet opens in a new tab:
2. Enter as much general information as possible and available (see below for details; all fields marked with an asterisk are mandatory).

**Note:** Only the top left part of the form can be filled in at this stage.

3. Save (✓) the case trigger. The Enclosure section is now open for editing.

4. Add Offence Place, Offence Date, Country/State/Area/Town, Additional Offence Country, Typology, Typology Other, Offence Description, Remarks on the Case Trigger form and save it.

5. Attach files such as documents or images using the Enclosures grid (see below).

6. Save (✓) the case trigger.

**General Information**

A case trigger contains the following general information under the 3 tabs: Trigger Details, Trigger Persons and Trigger Organizations.

**Trigger Details**

**Received From:** The name of the person lodging the original complaint or other initiator.

**Programme Manager:** The name of the Programme Manager responsible for lodging the Case Trigger

**Originating Site:** Select the office from which the case trigger originated.

**Initial Case Type:** Case Type is pre-selected and appears on the Case Trigger form (Case Type is set under Options in User Preferences and this appears as default on the form)

**Received Date:** The date on which the initial data for this case trigger was submitted to your organization.

**Level of Importance:** Select the scale of importance

**Anonymous:** unknown or unacknowledged name if the name of the person lodging the complaint is not known
**Case Management**

**Trigger Type:** Select the trigger type: e.g. Crime, Hotline Tip, Incident, Informant Report etc.

**Trigger Reference Number:** If the initial document has a reference number, enter it here.

**Delivery Method:** Identify the means by which the original information was delivered to you (email, fax…).

**Offence Place / Date /Country/State/Area/Town/ Description:** Enter any further known details about the reported misconduct behind this case trigger.

**Typology/Typology Other:** Select the systematic classification of Trigger Type (e.g. Procurement; Inventory/Assets)

**Offence Description:** Enter the detailed description of the offence that is committed for which the case trigger has been created.

**Remarks:** Remarks on the Case Trigger if any

---

**Enclosures**

To upload files as enclosures to the case trigger:

1. Click on **Append** (⊕) in the footer of the grid. An empty row is appended to the already existing document enclosures:

2. Click on **Add Document**. The document management form is launched:
3. Enter the **Title** of the document (mandatory). Make sure that the title is descriptive as it will be the means for identifying the document without opening it.

4. Enter any other available information about the document into the various fields.

If you want to upload an existing file:

5. Click on **Browse**. The operating system’s file chooser appears.

6. Select the file form the file system. The path and file name will be added to the field **Document file**.

7. Enter the **Title** of the document (mandatory). Make sure that the title is descriptive as it will be the means for identifying the document without opening it.

8. Enter any other available information about the document into the various fields.
Note: The document itself cannot be replaced. If you have to update it for any reason, you must delete the enclosure entry and create a new one around the new document.

Trigger Persons

Link to Case: Select the link to the case from the drop-down menu; it could either be an Implicated Person, Source, Subject, Victim or Witness

Name: Title, First Name, Middle Name, Second Middle Name and Last Name of person(s) associated with the case trigger are added in the relevant fields. First Name and Last Name are mandatory fields.

Communication: Add all the communication details of the Case Trigger Persons, which are available. This information is displayed in the form of cards, which can be enabled by clicking on the Add New icon on the sub-grid (✦) You can have any number of records for a Person.

Address: Add all the address details of the Case Trigger Persons. This information is displayed in the form of cards, which can be enabled by clicking on the Add New icon on the sub-grid (✦) You can have any number of records for a Person.

Communication Other: Any other additional Communication details can be added on the Trigger Persons form by clicking on the (✦) icon on the bottom of the grid.

Trigger Organizations

Link to Case: This is a mandatory field. The link to the Case can be selected from the drop-down menu. It can either be Source, Subject, Witness or Not Defined Yet.

Full Name: This is a mandatory field. The full name of the organization should be entered. Code Name, Business Sector, Contact Person and Comments should be entered if they are known.

Communication: Add all the communication details of the Case Trigger Organization, which are available. This information is displayed in the form of cards, which can be enabled by clicking on the Add New icon on the sub-grid (✦) You can have any number of records for the Organization.

Address: Add all the address details of the Case Trigger Organization. This information is displayed in the form of cards, which can be enabled by clicking on the Add New icon on the sub-grid (✦) You can have any number of records for the organization.

Communication Other: Any other additional Communication details can be added on the Trigger Organization form by clicking on the (✦) icon on the bottom of the grid.
Case Management
5.4 Create Case File

goCASE allows you to create case files from scratch, without the need for an already existing case trigger (see section 5.3: Case Triggers). No trigger information is entered in this scenario and the new case file starts empty. To create such a case file:

1. Click on the New Case File link in the Menu panel of the Dashboard or select Components ▶ New Case File from the menu.
2. A New Case File window pops up.

3. Fill in the metadata for the case (fields marked with an asterisk are mandatory):
4. Select the appropriate Case Type from the drop-down list.
5. Enter a descriptive name for the case file according your conventions.
6. Select the Initiating Office of the case. By default, your office is selected.
7. Choose the correct Trigger Type for this case.
8. Enter the Received Date of the case. By default, the current date is applied.
9. Click on Create. The case file is created and displayed in a new tab.

Note: The user creating the case file is defined as the Lead Investigator (see section 5.5.3: Case File Security Level).
5.5 Electronic Case File

Central to goCASE is the **Electronic Case File (ECF)** management module. This module allows you to capture, store and retrieve information relating to various objects. Typically, an electronic case file contains information on the people involved in the case, multimedia files (images, audio or video), information on bank accounts, events and more.

A typical goCASE case file looks like this:

![Case File Information](image)

The case file information is shown in a tab with two panels: The **Object Browser** and the **Case File Directory**.

### 5.5.1 The Object Browser

The object browser is designed to navigate within the Case File. Objects are added, deleted and modified using the object browser. It lists all object types associated with this type of case as well as all objects already added to the case within a tree structure. The number in brackets indicates the number of stored objects of a certain type.

1. Click on **Refresh** to update the object browser.

*Note: The current object will be opened when the Case Object list is refreshed. If an object is added; the new object should be opened, similarly if an object is deleted, the Object Type should open.*

1. Click on the **Expand** icon next to an object type to show the available objects of this type in the object browser.
2. Double-click an object type to show a preview of the available objects in the case file directory.
3. Double-click any object to open and display it.
Case Management

5.5.2 The Case File Directory

The right-hand panel displays the detailed information for whatever is selected in the object browser. By default, the meta information of the case is shown (as seen above).

The overview area of the panel presents the case identification number (CIN), the security level (see section 5.5.3: Case File Security), the case file name, the case type and the current status of the case. The table in the panel contains quick links to the objects within the case file as well as showing when it was added and by whom.

5.5.3 Case File Security Level

A crucial element of any Case File is the security. The Case Access Control in the case file manages the security level. Three different levels are possible:

Shared for read: Everyone using the goCASE application has access to the case file and its objects. However, users with this access will not have access to any of the object menus and will not be able to add, modify or delete any object information.

Restricted by ACL: Only users granted access in the ACL (Access Control List) have access to the case file. Information regarding the objects in these cases is displayed in the results lists of the search features. Only users who have been granted access in the ACL will be able to open and view the objects.

Blind: Even stricter than Restricted by ACL, objects from Blind case files are not returned in search results. Only persons with explicitly granted access to that case file have access to the data and will find it through the search functions.

Default Level

The default case file security level is set by the goCASE administrator; all new cases get this level assigned automatically. The default case file security is “shared for read” for a new case file.

Only the Lead Investigator, Second Investigators and the goCASE super users can change this setting or grant access to other users. A flag has been added to the goCASE settings form which says “Notify Reporting Officer of Case security changes”. If this flag is set to “YES”, whenever the security level of a case file is changed on the Case Access Control List, the current user’s reporting officer (the one changing the security level) will receive a message on the message board to say that the security level has been changed.

Note: The user creating a case file and thus opening the case automatically becomes the Lead Investigator and gets full access to the case file.

Manage Case Access

To change the basic permissions and to grant access to other users to the active case file:

1. Open the context menu of the Case File node in the Object Browser and select Case Access Control. The access control form is loaded and displayed:
2. To change the **Case Handling Group**, the **Case First Officer** or the **Case Second Officer**:
   
i. Click on Browse (🔍) near the field in question. The **Resource Selector** is displayed.
   
   ii. Select the desired person or group (see section 3.9: **Resource Selector**).

3. Change the **Classification Code** and the **Security Level** by selecting the new value from the respective drop-down list.

   **Note:** *Super users are managed by the goCASE security and cannot be changed in this form.*

4. Click on **Save** to apply your changes to the case.

To grant access to a user:

   i. Click on Append (+) in the footer of the Staff Access Control grid. The **Staff Selector** is displayed.
   
   ii. Select the desired person or group.
   
   iii. **Set Date Effective From** to the date from which the user is to be granted access. The current date is selected by default.
   
   iv. Activate the checkbox **Never Expires** if you want to grant access until further notice or deactivate it and select an expiration date in the field **Date Effective To**.
   
   v. Activate the checkbox **Case Staffing** if this person is actually working on the case, instead of just having access to it.
   
   vi. Select the **Role in Case** from the drop-down menu.
To modify the permissions of a user:

i. Select the user from the **Staff Access Control**. The name and current permissions are displayed above the bottom grid.

ii. Activate the **Read** and **Modify** checkboxes for all object types the user is to have read or write access to and deactivate any others. See y

iii. Click on **Grant Full Access** to activate all checkboxes with one click or on **Revoke All Access** to remove all permissions. Use **Grant Read** to give full read access but no write access.

Some object types in a case are associated with certain menu items in the goCASE application for analysis or further processing. Each of these menu items can be permitted or denied individually:

i. Select the user in question from the **Staff Access Control** grid as well as the **Case Object** type you wish to edit. The menu entries associated with the object type are listed in the bottom right grid.

ii. Activate all checkboxes for the menu items you want to allow for the user and deactivate any which remain.

iii. When finished, click on **Save** to apply your changes to the case.

**Note:** It is possible for a user to have access to only one object type within a case file. However, if a user has been added to the staff access control grid but has not been granted explicit access for objects and menu items, he or she will not have access to the case file at all.
5.5.4 Case Properties

Case properties are the metadata of a case file, such as the identification number, the priority and the responsible persons. To view and possibly edit the case properties:

1. Open the context menu of the Case File node in the Object Browser and select Case Properties. The properties form is loaded and displayed:

![Case Properties Form](image)

2. Edit the fields as required by entering text or selecting options respectively.
3. Click on Save to confirm your changes. The changes are applied and the properties window is closed.

Note: The case handling group and the Case First and Second Officers can also be changed in the case access control window (see section 5.5.3: Add Objects to Case File)
There are four ways to add an object to a case file: You can add a new object, copy an object from the central repository, link an object from the central repository or share an object with another case file.

**Note:** For details about the central repository refer to section 6: [Central Repository](#).

Adding objects is done via the context menu of the object types:

![Context Menu](#)

**Note:** If any of these menu items are greyed out it means that you do not have the necessary permissions.

### Add New Object

A new object is an object which is created within the current case file. Such an object will only be available in the current case file and cannot be accessed from other case files. To add a new object:

1. Open the context menu of the object type in the **Object Browser** and select **New**. The input form for the specific object type is displayed.
2. Fill in the form. Add as much information as possible to facilitate searching for the object.
3. Save (✓) the object.

### Copy Object from Central Repository

When copying an object from the central goCASE repository, you create a physical copy of the repository object. This means that while the object holds the same information as the repository object, all links between them are removed and the case object belongs to the case only. Any changes to the case object will stay within the case and all future changes to the repository object will have no effect on the case object. To copy an object:

1. Open the context menu of the object type in the **Object Browser** and select **Copy Object from Central Repository**. The **Object Picker** opens up and displays all the objects of the selected Object Type.
Select the object you want to copy and confirm with OK. A copy of the selected object is added to the case file.

**Note:** You can use the “quick label filter” for filtering the list before selecting an object (see section 3.3.5: Filtering Grid Data).

**Link Object from Central Repository**

This function creates a link between the current case file and the central repository. While the object will be displayed and used in the current case file, it still belongs to the repository. This means that any changes made to the object in the case will propagate back to the central repository and from there to all other cases using this object. Linked objects are labelled as underlined.

1. Open the context menu of the object type in the Object Browser and select **Link Object from Central Repository**. The Repository Object Picker is displayed.
2. Select the object you want to link and confirm with OK. A link to the selected object is added to the case file.

**5.5.5 Open / Edit Case Object**

To open an object within a case file and edit it:

1. Double-click the object in the Object Browser or open the context menu of the object and select **Open Object**. The object data is loaded and displayed.
2. Apply your changes to the data fields if necessary.
3. Save (✓) the object.

**5.5.6 Define Object Label and Content Type**

When a new object is added to a case file, the object’s label in the Object Browser is set to unknown. This status is updated as soon as the required data fields have been filled in (in the case of a person this would be the First Name and Family Name):
To change the label at a later stage:

1. Update the Object Label in the object view (see above).
2. If necessary, select a different Content type from the drop-down list.
3. Save (✓) the object. The Object Browser is updated accordingly.

5.5.7 Add Case Object to Calendar

Any object can be defined as a calendar event and added to the goCASE Calendar.

Open the object by double-clicking it in the Object Browser.

4. Click on Add to my calendar (open). The My Calendar selection window is displayed:

5. Select a Date for the event and enter a descriptive Subject.
6. Activate the checkbox Add to my case tasks if you want to create a to-do task together with the entry. Otherwise deactivate it.
7. Click on Add. The new event is added to the Existing entries grid.

5.5.8 Assign Case Object as Task

You can create a task that is directly linked to a case object and assign it to any goCASE user:
1. Open the object by double-clicking it in the Object Browser.
2. Click on Assign task ( ). The Assign Task window is displayed:

3. Enter a descriptive Subject and select a due date for the task in the Due by field (both mandatory).
4. Enter a Task Description task and a possible Task Outcome and set a Priority (not mandatory).
5. Activate the checkbox Assign to myself if you want the task to be yours (deactivate it otherwise).
6. Select other people as recipients by clicking on Append ( ) in the footer of the resources grid and selecting people from the appearing Resource Selector (see section 3.9: Resource Selector).
7. Click on Assign. The task is created and the selected recipients are notified (see section 4.3: To Do).

5.5.9 Content Validity

The content validity is a rating system for goCASE objects. By default, objects are not rated (“not evaluated”). To rate an object:

1. Open the object by double-clicking it in the Object Browser.
2. Click on Content validity ( ). The Object Evaluation window is displayed.
3. Select ratings for the **Source Reliability** and the **Content Validity**.
4. Enter the **Source of Data** (if known).
5. Click on **OK**. The rating is applied and shown on the object’s tab next to the icon.

### 5.5.10 Link Case Objects

For all objects within a case file it is possible to create links (connectors) to other objects. These links are then shown in the object view and allow users to quickly navigate to the target object:

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Object Label</th>
<th>Link Description</th>
<th>Confirmed Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>$</td>
<td>Bank Accounts CB 902249</td>
<td>Owner</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Persons</td>
<td>Adrian C Stewart</td>
<td>Event 101</td>
</tr>
<tr>
<td></td>
<td>Persons</td>
<td>Adrian C Stewart</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Record 1 of 13</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6. The **Connected Objects** tab displays any objects to which the selected object has been linked.

Depending on the type of objects that are being connected, a specific **Connection Rule** can be assigned. This rule creates a specific dependency between the objects.

1. Click on the link in the **Object Label** column to open the linked object.

The **Object Linked To** tab is only relevant for linked objects (see section 6: **Central Repository**), not for case-specific objects (see section 5.5.34: **Add Objects to Case File**). It displays the number of cases in which it is used as a linked object:
2. Click on the **View Details** button to launch the details with the Cases.

![Connected Objects](image)

3. Click on the **CIN** to open up the Case File.

   **Note:** *This is only possible if you have the necessary access rights to the other case file.*

**Create Link**

To create a new object link:

1. Click on the **Connected objects** icon (⊕) in the **Connected Objects** tab or open the context menu of the object in the Object Browser and select **Linked Objects**. The **Connecting Objects** window is displayed:
2. Select the **Objects List** from which you want to choose the linked object (current case file, object browser). The contents of this list are displayed in the list box.

3. Select the item to which you want to link from this list by double-clicking it.

   **Note:** You can use the “quick label filter” for filtering the list before selecting an object (see section 3.3.5: Filtering Grid Data).

4. Define a **Connection Rule** for the link (e.g. for persons this will be the type of relationship) and enter a descriptive explanation into the field **Link Description**.

5. Repeat this procedure as required.

6. Click on **Save** to establish the links in the goCASE database. The dialogue window is closed.

7. Refresh (F5) the Object Browser to make the updates visible.

   **Note:** Currently, the connections are based on the **Linked Objects**.

5.5.11 **Copy Case File Object as Link**

goCASE allows you to copy a link to an object to the system’s clipboard and to paste it into the Notes Clipboard (see section 3.8: Notes Clipboard), where it can be sent to other goCASE users, or to any other rich text field within the application:

1. Open the context menu of the object in the **Object Browser** and select **Copy Object As Link**.

2. Switch to the form where you want to paste the link (e.g. the Notes Clipboard).
4. Click on Paste Linked Object (⌘) or hit <Ctrl>+P on the keyboard. The link is inserted into the field.

5.5.12 Migrate Case File Object to Central Repository

It is possible to migrate objects of certain types from a case to the central repository in goCASE (see section 6: Central Repository). These objects will then be available for reuse in all case files:

1. Open the context menu of the object in the Object Browser and select Migrate to Central Repository. The object is moved from the case to the repository.
2. In the current case file, the object instance is automatically replaced with a link to the repository.

From now on, any changes made to the object will propagate to all other cases where the object is used.

5.5.13 Make Local to Case File

When a case file contains links to objects in the Central Repository (see section 6: Central Repository), it is possible to make a local copy of the object instead. This prevents further changes in the linked object that are applied in other case files from propagating into your case file and vice versa:

1. Open the context menu of the object in the Object Browser and select Make Local to Case File.
2. The object link is replaced with the object copy. All future changes will remain in the case file.

5.5.14 Share Object

A user can share an object with another case file.

1. Right-Click on the object, and select Share Object option on the context-menu.
2. On the Shared Objects pop-up window, select the Destination Case File
3. Select the check-box Notify Case Officer of the Destination Case if you want the Case Officers to be notified about the share.
4. You can also select the Resource and add a Message to the resource regarding the share.
5. Click on Share Object.
**Note:** *The Share Object button is only enabled if there is a destination case file.*

You can see which objects in a case file have been shared with another case:

1. Right-click on the Case File. It shows 2 tabs: **Shared with the case** and **Shared by the case**

2. Click on the **Shared by the case** tab, to see the list of all objects that have been shared by the case file.

3. Click on **Shared with the case** tab, to see the list of all objects that have been shared by other case files with this case file.

4. You can remove any object from the list of all objects that have been shared by the case file, by selecting the checkbox next to the object and clicking on **Remove Share** button.

5. You can copy the object from the list of objects that have been shared with this case, by selecting the checkbox next to the object and clicking on **Copy Object** button.

6. The object is now copied to the case file, with which it has been shared.

**Note:** *Once the object has been copied, the share can no longer be removed.*
5.5.15 Copy Case File

You can make a copy of the case file and remove those objects that should not be forwarded to the next team.

1. Select the **Case Type** and the **Originating Site** from the drop-down menus.
2. Select the resource from the Resource Selector for the **Case Officer** field.
3. You can select the relevant check-boxes (**All Objects, Objects by Type, Select Objects**) according to which objects you want to copy.
4. Select the check-box **Open New Case File** if you want to open a new case file with the copied objects.
5.5.16 Print Case File Object

To print the information of an object:

1. Open the context menu of the object in the Object Browser and select Print. A print preview window is displayed:
2. Send the file to a physical or virtual printer ( ).

5.5.17 Delete Case File Object

To delete an object from the active case file:

1. Open the context menu of the object in the Object Browser and select Delete. After a security check, the object is deleted.

Note: When you delete a “person” object, a copy of the deleted object is created and archived in the database.
5.6 Case Data and Object Types

Every Case File contains data objects of different types. The availability of these object types varies according to the type of the Case File and can be changed by your Administrator.

All the objects adhere to the Case Access Control settings. By default, each object created within a case is an independent instance. For reusing existing objects, goCASE has a built-in similarity check that identifies potential duplicates on creation. It is possible to reuse objects across Case Files using the Central Repository functionality. The following is a list of all available Case Objects, regardless of their case type:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📭</td>
<td>Case Details</td>
</tr>
<tr>
<td>📮</td>
<td>Prosecution Details</td>
</tr>
<tr>
<td>🧑‍⚖️</td>
<td>Persons</td>
</tr>
<tr>
<td>🏛️</td>
<td>Organization</td>
</tr>
<tr>
<td>🏛️</td>
<td>Authorities</td>
</tr>
<tr>
<td>📄</td>
<td>Documents</td>
</tr>
<tr>
<td>🎥</td>
<td>Multimedia</td>
</tr>
<tr>
<td>📕</td>
<td>Exhibits</td>
</tr>
<tr>
<td>📝</td>
<td>Notes</td>
</tr>
<tr>
<td>💰</td>
<td>Bank Accounts</td>
</tr>
<tr>
<td>🛠️</td>
<td>Tasking</td>
</tr>
<tr>
<td>🚗</td>
<td>Vehicles</td>
</tr>
<tr>
<td>🎨</td>
<td>Diagrams</td>
</tr>
<tr>
<td>🕒</td>
<td>Events</td>
</tr>
<tr>
<td>💥</td>
<td>Firearms</td>
</tr>
<tr>
<td>📜</td>
<td>Linked Cases</td>
</tr>
<tr>
<td>🚗</td>
<td>Vehicles</td>
</tr>
<tr>
<td>📞</td>
<td>Phone</td>
</tr>
<tr>
<td>🏡</td>
<td>Property</td>
</tr>
</tbody>
</table>
5.6.1 Case Details

The Case Details provide an overview of the case, showing the current workflow status, a description of the case, the Case Details, Extract, Final Outcome, Referral, Financial impact, Job Sheet and Case Resources.

Whilst basic details like Current Status, Case Handling Group., Internal Case Reference and File Name are displayed in the top screen; detailed information on the case is available in 7 separate tabs: Case Details, Extract, Final Outcome, Referral, Financial Impact, Job Sheet and Case Resources.

The File Cover provides an option to enter a brief offence description as well as the setup of the identified Financial Impacts which need to be represented in monetary value.

In the Extract tab, the Case Workers can enter a narrative about the case ideally giving a quick introduction and overview of the misconduct, the investigation progress as well as the involved persons.

In the Final Outcome tab, the Case Workers enter a narrative about the final outcome of the case.

The Referral tab is used when an Authority refers a case to another Authority. The Referred to field allows the user to select from the list of Authorities. The referrals can also be added as a pre-requisite form to the workflow control. It will have the same fields. If data has already been entered in the Case Details tab it will automatically show up in the referrals pre-requisite form.

In the Financial Impact tab, the value of an item (i.e. involved, destroyed, recovered or stolen) in local currency and the value recovered is displayed.

The Job Sheet provides a default checklist of information objects that need to be verified when processing the Case File. Relevant Jobs / Information Sources are indicated by a check. For each job, the current status, the corresponding Case Object as well as the person who performed the job can be set.

Case Resources shows a list of all resources (i.e. Groups / Persons) that have been granted explicit access to the case file. This can be setup by the Case First and Second Officer using the Case Access Control. For a Case Worker, the specific role in the context of this Case will be displayed. Users who have been granted access to a Case File can set themselves as Case Workers using the 'Add me as Case Worker' button.

The Case Workflow can also be managed on the Case Detail form. Click on the workflow icon 🔄 in the top section of the Case Details form to open the workflow window. The form displays the current status of the case and the current owner of the case. It allows forwarding to other users adhering to defined Workflow and Workflow Roles (defined by the Administrator). Once the current Transition Owner (i.e. the person to who the Case File is assigned to) finished the relevant tasks the Case can be forwarded to the next responsible person (i.e. the new Transition Owner). It is possible to forward the case to another user by attaching documents to the Case by clicking on the attachment 📄 icon.
5.6.2 Associated Reports

This relates to a list of reports, which are associated with that case file. These reports are also available in the Reports section of goCASE.

**Report Case Diary**

**Function:** Returns events and tasks added to the action diary for the specific case file.

**Parameters:** CIN, internal case reference, operational code name, content type, location

**Result:** Action, action title, start date, end date, action type, action status, location, description, content type.

**Note:** The report can be filtered by either administrative or investigative contents.

**Crime Diary**

**Function:** Returns the case extracts of the selected case files within a given period.

**Parameters:** Date from/to, CIN, Case Type

**Result:** CIN, Case File Name, Case Type, internal reference no., extract, received date.

**Workflow History**

**Function:** Shows the workflow history for the selected case as well as which workflow cycle the case belongs to.

**Parameters:** CIN.

**Result:** Cycle name, initiation date, current status, file duration (days), action, handled by, action date, elapsed days, note from handler, forwarded to, time limit, due date, task, properties.

**Case Hits**

**Function:** Returns all the searches initiated and the search strings associated with them within the case file.

**Parameters:** Date from/to, CIN, User

**Result:** CIN, Search Initiator, User, Date, Time, Search String

**Date Journal**
Case Management

**Function:** Lists all events for cases that the user has access to.
**Parameters:** Date from/to, Case Object, Object Type, Journal Type
**Result:** CIN, Case File Name, List of Events, Object Label, Object Type, Event Date, Brief Description

**Case Job Sheet**

**Function:** Lists all the entries from the job sheet as well as all the data from the job sheet tab
**Result:** Job, Responsible Resource, Status, Checked by, Checked on, Object Type linked To, Object Linked To and Comments

**Case File Access Log**
**Function:** Shows a list of when a specific Case File was accessed and by whom
**Parameters:** Date from/to, Resource
**Result:** CIN, Internal Case Reference, Case File Name, Access Date, Access Time, Resource Name, Case Worker and Case Officer

**Object Creation Log**
**Function:** Lists all the objects created and the resources that created them
**Parameters:** Date from/to, Object Type, Resource
**Result:** CIN, Internal Reference Number, Case File Name, Resource Name, Case Worker, Case Officer, Object Type, Object Label, Create Date, Create Time

5.6.3 **Object Persons / Individuals**

**Persons Directory**

1. Double-Click on the Object Type Label
2. A list of Persons with their respective images and details is available.
3. Double-Click on the relevant card to open the Person Object.

*Note: The layout of the images can be selected by clicking on the options on the top of the Persons Directory*
Object Browser

1. Expand the Person Object by clicking on the [+] to the left of the Object Type, to display a list of all individuals linked to the case as Implicated Person, Source, Subject, Victim and Witness. To view the details of the specific person, click on the Person’s name in the Object Browser.
The following information can be entered for each person:

**Profile** - Personal Data- link to Case is specific to the Person within the Case File. It is the only data which can be changed locally when an object is linked from the Central Repository.

**Biography** – Narrative on the personal history of the Person

**Miscellaneous** – relevant documents like Insurance card, Credit Card details, Driver License and also details regarding Service History and hobbies of the specific Person Object.

**Contact Details** – postal addresses and communication details of the Person

**Photos** – any available photo(s) of the concerned Person

**Associates** – any associates related to the Person

**Assets** – cash, property, bonds etc. and their detailed information
Person Context Menu

The following options are specific to the Person Object:

**Associated Forms**

Associated form is a list of pre-defined templates which can be linked to the specific person. These templates are set up by the System Administrator and may include templates such as **Search Order**. When the form is selected it is opened in an editable format and the data is pre-populated with the person information. Click on \( \text{arrow next to the Associated Forms} \) menu to open up the sub-menu for Associated Forms.

**Search for Match**

1. **Search for Match** is possible under **Quick Search** and **Advanced Search**
2. Under **Quick Search**, you can enter the search criteria in the search bar and retrieve relevant data
3. On selecting advanced search, it loads the search form and pre-populates the **Search Parameters** with the selected user details.
4. If necessary, edit or add to the parameters and save query under the **Query Name**.
5. To run a customized search based on the saved query, select one of the options from the **Saved Queries** field.
6. All possible results will be displayed in the Search Results grid.

**5.6.4 Object Organization**

1. A list of organizations displaying the **Object Label link**, **Code Name**, **Organization Name** and **Link to Case** is available by double clicking on the Object Type Label
2. Double-Click on the **Code Name** link to open the specific Organization form.
Object Browser

1. Expand the **Organization Object** by clicking on the [+] to the left of the Object Type, to display a list of all Organizations linked to the case.

2. To view the details of a specific organization, double-click on the organization’s name in the object browser.

3. The following information can be entered for each organization under the two tabs: **Profile** and **Contact Details**

   *Note: Organization offers the standard context-menu options.*

5.6.5 Object Documents

Documents menu shows a list of documents linked to a case. This form allows you to enter scanned or stored documents related to a specific Case File in the respective folders. Documents can be stored in the following folders, which are available in this object for every Case File: Requests for Information, Legal, Statements and Interviews, Forensic Files, Draft and Working Documents, Internal Correspondence, Report, Administration and Financial Documents

Documents Directory

1. A list of Documents displaying **Document Title**, **Document Type**, **Reference**, **From**, **To** and **Description** is available by clicking on the Object Type Label: "Documents (9)"
2. Double-Click on the **Title link** to open the document’s form.

3. If you would like to download specific documents to a folder in your desktop, select the **Include this document in the download list** check-box on the bottom of the form.

**Object Browser**

1. Expand the Documents Object by clicking on the [+] to the left of the Object Type, to display a list of all Documents linked to the case.

2. Select the check-box “**Include this document in the download list**” if you want to see the list of all documents in the Documents Directory of the Case File.

3. To view the details of a specific document, click on the document’s name in the object browser.

**Adding a Document**

Once the Document Object has been added to the Case File; enter the required information, **Title** and **Document Type**, as well as any additional information available.

1. Select the document to be uploaded from your computer or the network by clicking on the **Browse** button.
2. Navigate to the document location and select the document to upload. Click **Open**.
3. The document path will automatically be entered into the Document File input.
4. Click the **Save** button on the top of the screen.

**Revision History**

1. The latest versions and the revisions made to the document are displayed in this tab.
Case Management

2. To view the latest version of a document, click on the View Latest Version link in the Revisions History tab.

3. The document will be opened in its original format.

4. There are options to check-out an already existing document, upload a new version and release a document by clicking on the respective links.

<table>
<thead>
<tr>
<th>Changed By</th>
<th>Date</th>
<th>Time</th>
<th>Document Author</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intel Director</td>
<td>21/04/2010</td>
<td>11:51:22</td>
<td></td>
<td>Version 1</td>
</tr>
<tr>
<td>Intel Director</td>
<td>30/04/2012</td>
<td>15:37:14</td>
<td></td>
<td>Version 2</td>
</tr>
</tbody>
</table>

Editing a Document

1. To edit a document, click on the Check Out link in the Control Actions panel.

*Note: You will notice that the Check Out link is no longer highlighted and the Updated New Version and Release links are now highlighted.*

2. An entry has also been made in the controls grid, showing your user name, date, time, document author, and the status of the document (checked out).
3. There is also a link Version 1.
4. Click on the View Latest Version link to open the document.
5. Make the required changes to the document and save the document in your hard drive.
6. Now click on the Upload New Version link and navigate to the edited document on your hard drive. (The same way as when adding a document).
7. Save the new version.

*Note: The original version of the document will still be available (Version 1) next to the user’s name in the Control Grid. Click on the Version number to view the original document.*

Documents Context Menu
The following option is specific to the Documents Object:

**Load multiple documents**

This option is only available when opening the context menu for the Document object.

1. It is possible to add more than one document at a time.
2. When doing this, an object is created for each document. The **Title** is set as the document name. You must select **Document Type**, which is a mandatory field.
4. Navigate to the documents you wish to upload. It is possible to select more than one document or else select the first document and click OK.
5. You can set the **Default Document Type** by selecting a type from the drop-down menu.
6. The **Load Multiple Documents** form is displayed:
7. To add additional documents, click the and navigate to the next document.
8. Select the document and click OK.
9. Load as many documents as you wish to add.
10. To remove a document from the list, select the document and click the .
11. Once all the documents you wish to upload are in the list, click the OK button.
12. You can choose the Document Type by selecting one of the options from the Document Type drop-down field.

The documents will be loaded one at a time and added as individual document objects.

**Open Document:**

This option is available when opening the context menu for a document object directly.

**Open Document** directly opens the latest file revision without needing to navigate through the tabs.
Create Sub-Folder

This option is available for all objects. You can create a sub-folder for any of the available object types in the case file.

1. Right-Click on any of the Object Types.
2. A new sub-folder is created within that Object Type.
3. You can move around objects within the same object type or between different object types within a sub-folder by drag and drop.

4. You can rename a sub-folder.
5. Right-Click on the sub-folder to open the context-menu which is the same as the parent object type.

Note: Sub-Folder labels are not allowed to be empty. A sub-folder can only be deleted if it is empty.

5.6.6 Object Multimedia

Multimedia Directory

1. Double-Click on the Object Type Label
2. A list of Multimedia objects with their respective images and details are displayed.

Note: Multimedia types supported by goCASE include Audio, images and videos.

Object Browser

1. Expand the Multimedia Object by clicking on the [+ ] to the left of the Object Type, to display a list of all Multimedia objects linked to the case.
2. Double-click on the name of the specific multimedia object in the Object Browser to view the object details.( example below shows the Multimedia Type -Images)
Adding a new file

You can load any file specific to a multimedia object.

1. Click on Browse to select the file you want to load from the File Selector.
2. Navigate to the file you wish to upload.
3. To remove a file from the list, select the file and click .
4. Once the files you wish to upload are in the list, click the OK button.
5. The files will be loaded and added as individual objects.
6. You can download all the uploaded files by clicking on the Download All Files button.

5.6.7 Object Exhibits

Exhibits Directory

1. Double-Click on the Object Type label .
2. A list of Exhibit Sets with the Exhibit Description, Number of Exhibit Items and Acquisition Date is displayed.
3. Click on the Exhibit Description link to open the form of the Exhibit set.
Case Management

Object Browser

1. Expand the Exhibits Object by clicking on the [+] to the left of the Object Type, to display a list of all Exhibit Sets linked to the case.

2. To view the details of a specific exhibit set, Click on the exhibit set’s name in the object browser.

1. Each exhibit has two tabs: **Exhibit** and **Exhibit Items**

2. On the first tab enter the **Exhibit Set Description**, **Reference Number** and **Remarks**.

3. The **Exhibit Set Move** shows the movement of the exhibits as with their movement reference number, date, type received from and the current owner of the exhibit. This is a read only list. To add to the Exhibit Set movement registry (see section 13. **Exhibit Registry**)

4. To add an exhibit item to the exhibit set, select the **Exhibit Items** tab.
5. To add an exhibit, click [+ ] at the bottom of the Exhibit Items grid.
6. This will append a row to the grid and clear the text fields in the Item Detail panel.
7. Enter all information in the Item Detail Panel.
8. Once all required information has been entered, click on Save button.
9. The Exhibit Items grid is updated with the new information.
10. To edit an item, select the item in the Exhibit Items grid.
11. The Item Detail panel will automatically be populated with the selected items information.
12. Edit the information and click Save.

5.6.8 Object Events

Events Directory

1. Double-Click on Object Type Label. Events (10)
2. A list of all Events displaying the Event Type, Title, Location, Start Date, End Date, Status and Description of all the events registered for the Case is displayed.
3. Click on the Title link to open the Event form.

Object Browser
1. Expand the Events Object by clicking on [+] to the left of the Object Type, to display a list of all Events linked to the case.

2. Double-Click on the specific Event to view the details of a specific Event in the object browser.

**Adding a new Event**

1. Right-Click on the right of the Object Type to select **New** from the context-menu.

2. Enter all available information on **Event information, Event Resources** and **Event Parties**.

3. If you want the event to be added to the **Diary of Action**, select the respective checkbox in this form

4. Click on **Save**.

---

**5.6.9 Object Notes**

**Notes Directory**

1. Double-Click on the Object Type Label

2. A list of all Notes objects with the **Subject, Title, Date** and **Created By** is displayed.

3. Click on the **Subject link** to open the Notes form.
Object Browser

1. Expand the Notes Object by clicking on the [+] to the left of the Object Type, to display a list of all Notes linked to the case.
2. To view the details of a specific Note, click on the Notes in the object browser.

5.6.10 Object Bank Account

Bank account represents one specific account held at a specific institution.

Bank Account details can be stored in two tabs: Account Information and Account Holder Details

Account Information holds static account information such as IBAN Code, Swift Code, Account Number and Type. In addition to the above, the latest known account balance can also be set with the respective date.

Account holders can be assigned from the current case file. This can either be an Organization or a Person. Setting multiple Account Holders is possible whereby for each entry a specific Account Holder Type i.e. a role must be assigned.

Bank Account Directory

1. Double-Click on the on the Object Type Label $ Bank Accounts (7)
2. A list of Bank Accounts with the **Institution Name**, **Account Number**, **Account Name**, **Account Type** and **Account Status** are displayed.
3. Click on the **Account Number link** to open the Bank Account form.

**Object Browser**

1. Expand the Bank Account Object by clicking on the [+ to the left of the Object Type, to display a list of all Bank Accounts linked to the case.
2. To view the details of a specific Bank Account, click on the Account Number in the object browser.
3. To add a new back account object, click on **New**, enter all available information on the Bank Account and click on Save.

<table>
<thead>
<tr>
<th>Object Type: Bank Accounts</th>
<th>Object Label: Serving Account - 130556697</th>
</tr>
</thead>
</table>

**5.6.11 Object Tasking**

**Tasking Directory**

1. Double-Click on the Object Type Label Tasking (3)
2. A list of Tasks with the **Object Label**, **Subject**, **Due By**, **Start By**, **Staff Member**, **Required** and **Resource Task Status** for the currently logged in user is displayed.
3. Click on the **Subject link** to open the Task form.

**Object Browser**

1. Expand the Tasking Object by clicking on the [- to the left of the Object Type to display a list of all Tasks linked to the case.
2. To view the details of a specific Task, click on the Label in the object browser.

13. Enter the Task information in the **Task Details** Panel.
14. The **Assigned By** field is populated by the system and cannot be edited by the user.
15. When checking the **Add to Diary of Action** check box, the task will automatically be added to the Diary of Action Report.
16. Now assign the task to users by clicking on the [+] at the bottom of the **Assign Task** grid. The Resource Selector pops up.
17. Select the resource/s you wish to assign the task to and click OK.
18. Now change the **Required** and **Completion Status** for each resource.
19. The Completion Status can be changed but the status of the user who created the task, or the resource the task was assigned to can also be changed.
20. If the **Assign to Self** check box is selected, the task will automatically be assigned to the current user.
21. When a task is entered and assigned to a user, a message is sent to the user and appears in the users **Message Board** (see section 4.5 **Message Board**) on the goCASE portal.
22. When the task that has been assigned to a particular user has not been completed by the due date, a reminder is sent to the user and that appears on the message board.
23. Double-click on the message in the Message Board to open the Task object.

24. The [Mark As Complete] button is only available if the current user is in the Assign Task list.

25. The Completion Status is automatically set to Complete for the current user when the Mark As Complete button is clicked.
5.6.12 Object Vehicle

Vehicles Directory

1. Double-Click on the Object Type Label Vehicles (2)
2. A list of Vehicles with the Plate No., Vehicle Registration Number, Colour, Category, Vehicle Make and Engine Number are displayed.
3. Click on the Vehicle Number to open the specific Vehicle details.

Object Browser

1. Expand the Vehicles Object by clicking on the [+] to the left of the Object Type, to display a list of all Vehicles linked to the case.
2. To view the details of a specific Vehicle, click on the Label in the object browser.
3. Enter the Registration and Vehicle details.
4. Now add the Owner/Holder Details.
5. To add the Owner, Click on the [+] at the bottom of the grid. It will add a new row to the grid.
6. Select a Person or Organization from the drop down in the Owner/Holder List.
7. If the person has not yet been registered in the Case File, select New Object from the Person Object context-menu and enter the Persons details.
8. To add a photo of the Vehicle, click on the append icon [+] at the bottom of the grid. Enter the Capture date, Notes and select the Default Photo check-box if you want to set the photo as the default photo.
5.6.13 **Object Firearm**

**Firearms Directory**

1. Double-Click on the Object Type Firearm (4)

2. A list of Firearms with their respective License Number, Firearm Type, Firearm Model, and Colour is displayed.
3. Click on the Firearm Type to open the Firearm details form.

**Object Browser**

4. Expand the Firearms Object by clicking on the [+] to the left of the Object Type, to display a list of all Firearms linked to the case.
5. To view the details of a specific Firearm, click on the Label in the object browser.
6. Enter the **License Details**, **Manufacturers Details**, **General Features** and **Seizure Details** in the respective Panels on the form.

7. In the **Ammunition** tab, enter the **Ammunition Identification/Ammunition Seizure** details.

8. In the **Photos** tab, add the Firearms photo, if any.

9. Click On **Save**.
5.6.14 Object Phone

Phone Directory

1. Double-Click on the Object Type Label \( \text{Phones (2)} \)
2. A list of Phone Devices with their respective numbers etc., which are linked to a Case, is displayed.

Object Browser

3. Expand the Phone Object by clicking on the [+] to the left of the Phone Type, to display a list of all the Phone Devices.
4. To view the details of a specific Phone device, click on the Label in the object browser.
5. To add a new Phone Object, select the option New.
6. It opens up the Phone Details form.
7. Enter all the relevant details on this form.
8. Enter the desired attributes and click on Save.

5.6.15 Object Property

Property Directory

1. Double-Click on the Object Label \( \text{Property (1)} \)
2. A list of Property objects, with their Property Types, Description, Value etc. which are linked to the case are displayed.
Object Browser

3. Expand the Property Object by clicking on the [+] to the left of the Property Type to display a list of Property objects.

4. To view the details of a specific Property, click on the Label in the object browser.

5. To add a new Property object, select the option New.

6. It opens up the Property Details form. It has two tabs: Property Profile and Photos.

7. Enter all the relevant details on this form.

8. Enter the desired attributes and click on Save.

5.6.16 Object Linked Cases

A linked case is a link to another case in the system.

Linked Cases Directory

1. Double-Click on the Object Type Label

2. A list of Linked Cases is displayed.

3. The linked cases are displayed in a card form with the File Name, Security Level, Case Type, Status and Link Description.
4. Expand the **Linked Cases** Object by clicking on the [+]. to the left of the Object Type, to display a list of all Cases linked to the case.

5. To view the details of a specific Case, click on the Label in the object browser.

6. When opening the Linked Case, the Case File Directory is displayed. (see section **The Case File Directory**)

7. Open any of the objects by clicking on the Object Label of the specific object in the Linked Case Directory.

8. To Link a case to the current case, right-click on the Linked Cases object label and add a new object.

9. The **Case Selector** pops up.

10. Select the cases from the Case List, which you wish to link to your Case File.

**Note:** The left panel provides the ability to filter the Case List on the right according to Case Type.

11. Select multiple cases by selecting the check-boxes in the left column of the Case List, or by selecting the check-box at the top of the column (this will select all case files).

**Note:** Only the cases to which you have access to will be displayed in the Case List.

12. Once you have selected the case/s click on OK. The cases are added as objects to the Linked Cases object.
5.6.17 Object Diagrams

Any object in the Electronic Case File can be linked to other objects within the same case file or outside the Case File (always abiding to the overall Case Access Control Settings). For example, details of an individual can be linked to “fact-supporting” documents from which the relationship records are established. Such links can also be presented visually (diagramming and charting). There is “auto save” functionality in the diagrams, so the user can leave the diagram and come back to it and the changes will be reflected.

The visualization feature (Diagramming) is a built-in component, which is easy to use. Using the embedded diagramming tool, the information stored in case files can be further analysed or used to identify and display evidence by generating different types of diagrams (association matrix, event flow charts, commodity flow charts, telephone call logs etc.). This shall assist the analyst in spotting patterns as well as drilling down to a more detailed level.

For each Case File, multiple diagrams can be created. Please note that a diagram always reflects the latest status of a Case Object. This means that when an object is e.g. deleted or renamed it will affect all Case Diagrams in which the object is used.

Add to Case File

You can add a diagram to a Case File by clicking on the Add to Case File button. The diagram is added to the selected Case File.

Share Diagram

You can share the diagram with another Resource in a Case File by clicking on the Share Diagram button. In the Share Diagram window, select the resources you would like to share the diagram with and notify the selected resources with a message if desired.
In the Shared Diagrams tab, you will see all the diagrams, which have been shared by other resources.

<table>
<thead>
<tr>
<th>Diagram Name</th>
<th>Staff Member Name</th>
<th>Date Shared</th>
</tr>
</thead>
<tbody>
<tr>
<td>My diagram 1</td>
<td>Beverly MULLEY</td>
<td>17/06/2015</td>
</tr>
<tr>
<td>My diagram 1</td>
<td>goCase Team</td>
<td>17/06/2015</td>
</tr>
<tr>
<td>My diagram 1</td>
<td>Alan Mancio</td>
<td>17/06/2015</td>
</tr>
<tr>
<td>My diagram 1</td>
<td>Amir Dorra</td>
<td>17/06/2015</td>
</tr>
<tr>
<td>My diagram 1</td>
<td>Anais NAU</td>
<td>17/06/2015</td>
</tr>
<tr>
<td>My diagram 1</td>
<td>Andreia Boer</td>
<td>17/06/2015</td>
</tr>
<tr>
<td>My diagram 1</td>
<td>Andrew Kalesniki</td>
<td>17/06/2015</td>
</tr>
<tr>
<td>My diagram 1</td>
<td>Ben Swanson</td>
<td>17/06/2015</td>
</tr>
<tr>
<td>My diagram 1</td>
<td>Dan Wilson</td>
<td>17/06/2015</td>
</tr>
<tr>
<td>My diagram 1</td>
<td>Donilo Galsapao</td>
<td>17/06/2015</td>
</tr>
<tr>
<td>My diagram 1</td>
<td>Dean Norsley</td>
<td>17/06/2015</td>
</tr>
<tr>
<td>My diagram 1</td>
<td>Dusan Janic</td>
<td>17/06/2015</td>
</tr>
<tr>
<td>My diagram 1</td>
<td>Emily Tarr</td>
<td>17/06/2015</td>
</tr>
</tbody>
</table>

Create Diagram

There are two possible starting points for creating a diagram.
1. Right click on **Diagrams** in the Object Browser to get the two options: **New** and **Linked Objects Diagram**

**New:** Creates an empty diagram

**Linked Objects Diagram:** Creates a diagram with all available Case Objects and shows the known connections between them. Links can either be confirmed or not confirmed. Non-confirmed links are indicated by dotted lines.

*Note:* The diagramming functionalities are identical in both cases

---

Change object positions

1. Select the objects you want to move on the drawing area as follows:
2. Click on the object to select it.
3. To select multiple objects one by one, hold either the <Shift> or the <Ctrl> key down and click on the objects in succession before releasing the <Shift> or <Ctrl> key.
4. To select multiple objects in an area, make sure that the “Toggle pan mode” function (مادة) is deactivated (see section 0: The toolbar functions for details).
5. Click and hold the mouse button, then drag a rectangle frame around the area you want to select. Release the mouse button.
6. Drag-and-drop the objects to their new positions.

Connect objects

Any two objects on the drawing area can be connected by a line, a so-called “connector”. This connector is more than just a graphical representation of a relation, as it has attributes:
To create a link between two objects:

1. Make sure that linking is enabled (Options ▶ Allow Linking; The toolbar functions for details).
2. Move the mouse cursor over the centre of source object; it changes into a hand symbol.
3. Hold the mouse button down and drag the cursor to the destination object. A line appears.
4. Release the mouse button. The connector is created.
5. Delete Objects
6. Any selected object can be deleted by hitting the <DEL> key on the keyboard. If you want to undo the change, simply click on the “Undo” icon in the toolbar (.undo).

Delete objects and connectors

Any object or connector can be deleted, if necessary.

7. Select the objects and/or connectors you want to delete.
8. Hit <DEL> on the keyboard.

Note: When you delete an object, all connectors leading from and to it are automatically deleted as well.

The toolbar functions

The diagram editor’s toolbar contains the following functions:

Note: The toolbar contains icons for diagram-related features. Data-related functions are accessed via the context menu of the drawing area.

Basic functions:

Undo (redo): Revert your last change on the diagram.
Redo (redo): Revert wrong “Undo” actions and restore the previous state.
Timer (timer): “Toggle” icon. Activate the timer and click on “Undo” to visualize in slow motion the creation of the diagram in reverse order (all actions are undone one-by-one until there’s nothing left to undo); click on “Redo” with activated timer to rebuild the diagram to its current step step-by-step.
Print (print): Opens the Print Preview dialogue window for printing the diagram on your default printer.
**Export ():** Export the diagram to the file system. Available file formats: *.jpg, *.png (single file or whole image sequence of the creation steps), *.svg, *.ppt (creation steps as individual slides) or *.xml.

**View functions:**

- **Zoom in ( or <Ctrl>+<+>):** Increase the zoom factor of the diagram.
- **Zoom out ( or <Ctrl>+<->):** Decrease the zoom factor of the diagram.
- **Zoom to fit ():** Show the whole diagram in the application window (the actual zoom factor is calculated automatically).
- **Overview ():** “Toggle” icon. Opens an integrated overview window in the lower right corner of the diagram. This window allows quick scrolling to remote diagram sections and zooming.

**Edit functions:**

- **Toggle pan mode ( or <Space>):** Changes the “dragging” behaviour of the mouse in the diagram. Active: Moves the drawing areas. Inactive: Drags a selection rectangle.
- **Redraw ():** Redraws the current diagram (e.g. in case the view gets distorted).

**Layout functions:**

- **Force directed layout ():** Rearranges the diagram so that all connectors are of equal length and show no crossings.

![Diagram](image1)

- **Layered digraph layout ():** Rearranges the diagram by focussing on the shortest path between the objects. Each distinct set of objects (i.e. only connected among each other, not with other objects) is one layer.

![Diagram](image2)

- **Tree layout ():** Aligns the objects as a tree structure, starting with the root element at the left border.

![Diagram](image3)
**Time layout (✓):** Shows the transaction timeline: Transactions from/to, recipients and amounts.

**Group (✓):** Combines multiple selected objects into one logical object. This means that when one object of the group is selected all other objects of the group are selected as well. A rectangle is drawn around the group.

**Ungroup (✓):** Removes a group and separates its objects again.

**Align centred horizontal (✓):** Aligns all objects in one column below the previously selected object.

**Align centred vertical (✓):** Aligns all objects in one row to the right of the previously selected object.

**Find longest path (✓):** Determines the longest path, starting from the selected object, and highlights it. “Longest path” means the object connected over the most connections with the start object.

**Line type (✓):** Determine the looks of the connectors here (click on ▼ to show the options). You can change the stroke of the line (solid, dotted) and the form (orthogonal, Bezier, straight).
Expand (اظهار): The selection for automatically extending objects with their associated objects (i.e. showing all objects of certain types that are connected to a core object type).

i. Click on ▼ to show the selection window
ii. Select the types of objects to be shown with a certain object type (e.g. all accounts connected with the persons in the diagrams)
iii. Click on ✅ to confirm the selection. The view is updated accordingly.

Note: A once applied expansion cannot be removed by simply deselecting it from the properties. Use “Undo” instead.

Node visibility (숨기기): Use this function to temporarily hide certain kinds of objects from view.

i. Click on the icon to open a drop-down list.
ii. Show (اظهار) or hide (숨기기) the object types as you like.
iii. Click somewhere in the diagram window to apply the changes. The view is updated accordingly.

Link visibility (숨기기): Use this function to temporarily hide certain kinds of connectors from view. Handle exactly like the node visibility.

Options: A collection of different options for the diagram editor. Click on the icon to show the options in a pull-down menu:

i. Show Background Grid: Shows a grid which helps arranging the objects.
ii. Auto-detect Duplicates: Automatically groups items of same type and name.
iii. Allow Linking: When active, connecting objects with connectors is enabled.
iv. Hide Link Labels: Activate to hide the labels of the connectors from view.
v. Hide Node Labels: Activate to hide the labels of the objects from view.
vi. Mark Internal Objects: When active, objects existing in the database are displayed in bold. All external data e.g. bank transaction information is still displayed in regular font weight.

vii. Show Links Without Aggregating: All links with the same type referring to the same object can either be grouped in one link or shown as individual links.

Example:
Money transferred to the same account in multiple transactions is either shown as one connector with the total value or as multiple connectors with the respective partial amounts.
i. **Keep Grouping After Expansion:** Makes a group from the already expanded items before expanding the new ones.

ii. **Disable Auto Layout Expansions:** Regardless of the chosen layout, it places the expanded items directly beside the existing ones.

**Clear options (_reset):** Sets all previously defined options back to the defaults.

**Search:** Enter a search term into the field and select from the auto-completion suggestions to jump to the corresponding object in the diagram.

<table>
<thead>
<tr>
<th>Jump to</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACC-3.0-00H</td>
</tr>
<tr>
<td>ACC-3.0-007</td>
</tr>
<tr>
<td>NZSB-AU-A1</td>
</tr>
<tr>
<td>NZSB-AU-A22</td>
</tr>
</tbody>
</table>
Data analysis functions

The functions and options for data analysis can be accessed via the context menu of the items on the drawing area.

*Note:* The toolbar contains icons for diagram-related features. Data-related functions are accessed via the context menu of the drawing area.

**Person, Cases, Organization, Document, Multimedia etc...** Display all objects of the chosen type connected with the selected object in the goCASE database in the drawing area.

**All relations (≡):** Add all objects of all types from the goCASE database which are connected with the selected object to the drawing area.

**Collapse Children (้ง):** Hide all “child nodes”, i.e. the objects connected with the currently selected object through outgoing connectors.

Snapshots

A snapshot is a capture of the state of the diagram at a certain time chosen by the user, much like bookmarks. Snapshots can be navigated to, viewed or set current in the edit screen. See menu and shortcuts below:

Add Snapshot:

1. Add new snapshot (Ctrl+B) opens a new window.
2. You can enter a description for the snapshot here.
3. You can add more than one snapshot which can be edited later in the snapshot tracker.

**Snapshot Tracker:**
Set Active: This will close the tracker and replace the current view with that of the snapshot.

Delete snapshot: will permanently remove the snapshot

Move snapshot forward/backward: will change the sequence of the snapshots

Export Snapshot to PowerPoint: will create and open a new Microsoft PowerPoint file with the snapshots as slides and the description as title.

Close the tracker view (Esc): this will also return to the current state before invoking the tracker.

Note: (Tab / Shift-tab) as well as clicking on a snapshot will set focus to that snapshot, where the user can edit the description text.

Query Based Link
Query Based Link is invoked from the Diagramming Person object context-menu. You can select any combination of searches which will then filter a list containing all matches in the database that fit the selected criteria. You have the option of adding these matches to the diagram by linking them to the invoking person with the name of the match stated in the link itself.
**Matching Criteria list:**

The matching criteria list is that of the person selected to invoke the query based link dialogue. Supported matching criteria include the following:

- Offence match
- City match
- Occupation match
- Nationality match
- Street match
- Resident match

**Found Objects list:**

You have the ability to select more than one criterion to search for. The system will give the results in the found objects list which is the intersection of the selected criteria. You have the option to either select or de-select the results and add them to the diagram. Once added the diagram will be displayed with the dotted line as the matching link with its criteria.
Modelling

All Case Objects available in the Case File can be used in the diagram. The Case Objects List on the right-side of the screen shows all Case Objects grouped by category.

1. To visualize an object on the drawing area, select it in the Case Objects List, drag it onto the drawing area and drop it.

2. To delete, click on the object and hit the <DEL> key on the keyboard (works only for objects within the drawing area).

Connect Objects

Any two objects on the drawing area can be connected by a line or a so-called “connector”. This line is more than just a graphical representation of a relation, as it has attributes:

To create a link between two objects:

1. Enable **Allow Linking** in the **Options** toolbar entry

2. Move mouse cursor over centre of source object; it changes into a hand symbol

3. Hold the mouse button down and drag the cursor to the destination object. A line appears.

4. Release the mouse button. The connector is created.

5. An object can be deleted by hitting the <DEL> key on the keyboard. If you want to undo the change, simply click on the “Undo” icon in the toolbar (.undo). 

6. A connection of this type will not be stored in the **Linked Objects** details of the Case Objects.
Case Management

7. To save this link globally (meaning these objects will have a **Linked Objects** link that will always be displayed in the **Connected Objects** section of the Case Object (see screenshot) proceed as follows:

8. Right-Click on connection line and select **Properties**. The following dialog appears:

9. To save the link globally at least a description text has to be set. The connection rule offers a detailed description of the kind of relationships the two objects share.

10. Clicking on **OK** saves the connection properties and shows the description text on the drawing area.
11. The connections will also be displayed in the Linked Objects section for the now connected objects.

12. Deleting the link is possible by clicking on the connection line and hitting the <DEL> key on the keyboard.

13. Editing the link is possible using the Properties menu of the connection line (right click).

Change object positions
1. First a Case Object must be selected on the drawing area.
2. Click on it with the left mouse button.
3. To select multiple objects at any of the following options is possible

Selection frame:
14. Click and hold the mouse button and drag a frame over the objects you wish to select
15. Release the mouse button.
16. Select specific objects by holding either the <ALT> or <SHIFT> key on the keyboard and clicking on the desired objects.
17. Drag and drop the object(s) to the new position.

Delete Objects
Any selected object can be deleted by hitting the <DEL> key on the keyboard. If you want to undo the change please click on the UNDO icon in the toolbar.

Graphical Analysis
The following options help in performing a data analysis right from within the Case Diagram.

Open Object Details
Right click on any Case Object in the Diagram and select **Properties**

The following dialog appears:

![Node Properties dialog](image)

Clicking on **Object ID** opens the details page for the selected object. **Case ID** navigates to the Case the object is used in.
**All Relations**

By selecting **All Relations** in the context menu all objects linked to the currently selected one will be displayed on the drawing area automatically.

In order to hide the linked objects select **Collapse** in the context menu.

**Show Phone Calls**

Available for the following Case Object types:

- Persons
- Organizations
- Phones

Any phone data imported using the ‘External Data’ functionality will be added to the diagram.

The following options are available.

**Volume and Direction:** Shows the totals of phone calls connection two parties.

**Calls Network:** Shows all involved parties without connection details only if there is a connection or not.
Social Network

Social Network will show all Persons that are linked to the selected object in the diagram.

Show Financial Transactions

Available for the following Case Object types:

- Persons
- Organizations
- Bank Accounts

Any transactions uploaded using the External Data functionality will be displayed here.

Transactions with directions and amounts will be shown in the diagram.
5.6.18 Object Authorities

Authorities Directory

1. Double-Click on the Object Type Label Authorities (1)

2. A list of Authorities with the Code Name and Name of the Authority is displayed.

3. Click on the Code Name to open the Authority form.

Object Browser

1. Expand the Authority Object by clicking on the [+] to the left of the Object Type, to display a list of all Authorities associated with the Case File.

2. To view the details of a specific Authority, click on the Label in the object browser.
3. Enter the **Authority Profile** details and click on **Save**.

4. Select the **Contact Details** tab and enter the address, phone numbers and any other communication details by clicking on the [+] at the bottom of the respective grids and entering the information.
5.7 Matching Objects

Matching Objects is a built-in functionality for identifying already existing objects on creation.

Your administrator can set up rules for determining a Matching Rank which indicates the possible level of matching with an already existing object. This rank helps identify the objects which are most likely to be similar to the current one.

*Note: The Matching Rank can be configured or deactivated using System Administration / Objects / Matching Objects*

Once a possible match is identified the user has the option to display the details of the already existing object and to use this one instead of the newly created one or to continue creating a new object. For example: create a person with the same D.O.B and Last Name.
5.8 External Data

The External data component provides the option to import and analyse external Excel Files (.xls) that contain either Phone Records or Bank Transactions.

With this functionality the user can identify call and transaction patterns and see if some of the involved persons or organizations are already registered in the system be it account statements or phone bills / call records. The analysis screens allow convenient navigation from the external data to the identified Case Files and Case Objects.

The system provides means of mapping the columns in the provided files against the table structure within goCASE. After completing this mapping process the data can be uploaded into one of the following Case Objects:

- Person / Individual
- Organization
- Phone

The Analysis functionality provides means of comparing the imported data against already available data within the goCASE system and provides further analysis options like Pivot Table and Diagram as well as a match score for identifying how probable a match against a specific Case Object is.

5.8.1 Open External Data functions

1. Select a Person, Organization, Bank Account or Phone object in the Case Object Browser and open the context menu

2. Three options are available under External Data
   - Load External Data
   - Communication Analysis
   - Financial Analysis

5.8.2 Create an Importer

As the structure of the source Excel files can differ even for similar scenarios; goCASE provides an option to create Importers that map specific Excel file structures against the goCASE data structure. It is possible to create multiple Importers which can be shared
amongst goCASE users. For example, mobile invoices from provider XY that share the same structure for different customers.

1. Select **Load External Data** for a suitable Case Object (Person, Organization or Phone)
2. The **Load and Verify Data** tab is highlighted
3. Click on **Create an Importer** or **Edit/Delete Importers** tab whether you want to create a new Importer or if you want to edit/delete an existing one respectively
4. Select an excel file with the structure you want to map by clicking on the **Browse** button.
5. Specify an **Importer Name**. Alternatively you can select an already existing Importer in the Importer Name dropdown which will then be opened for edit.
6. Select the **Type of Data** – Phone or Bank Transactions
7. By selecting **Make Public** the importer will be available for all goCASE users. Public Importers will be indicated with an asterisk after the name.
8. The **Structure of Data** can be either **Bilateral, Unilateral with directional flag** or **Unilateral without directional flag**
9. Please select the relevant worksheet of the original Excel file in the **Source Types** dropdown.
10. Based on the selection; the appropriate goCASE target fields will be displayed in the **Destination Column** section.
11. Mandatory fields (fields that need to be mapped in goCASE) are indicated with an asterisk (*). Saving the importer will not be possible unless all mandatory fields have been mapped.

**5.8.3 Create a Mapping**

1. Create a mapping between a source and destination field / column by selecting the appropriate value in the Source column from the drop-down
2. Once all mandatory attributes have been mapped save the importer by clicking the save icon. It will now be available in the **Load and Verify Data** tab as a new entry in the **Importer Name** dropdown.
In order to load and verify data you can use an already existing public importer or create a new one.

1. **Load and Verify Data** tab is displayed.
2. Select the Excel file you want to import by clicking on **Browse**.
3. In the **Excel Sheet Selector** window select a worksheet to use.
4. Select an importer from the **Importer Name** dropdown.
5. Set a **File Provider**.

File Provider indicates who the originator of the file is. It is a Person, an Organization or an Authority that is already contained in the Case File. An example would be a local bank or an official authority (e.g. tax authority).
Case Management

Note: ‘Map to’ displays, depending on the selected importer type (bank transaction, phone) the Bank Accounts or Phones owned by the currently selected Case Object.

7. In case the Map to drop-down is empty, please check if the following information has been set for the Case Object.

Bank Account

For a Bank Account object in the Object Browser; add the Organization or Person to the Account Holder Details grid.

<table>
<thead>
<tr>
<th>Account Holder Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Entities</strong></td>
</tr>
<tr>
<td>Kessan, Harry</td>
</tr>
</tbody>
</table>

Phone

Data can be uploaded for a Phone object (in the Object Browser) which need not be associated to a Person or Organization.

The other option is to set a phone entry for a Person or Organization in the Contact Details.

8. Click on Preview to visualize the data from the original file using the selected importer.

9. In case of a mismatch or mapping issues a corresponding message will be displayed.

10. Any mapping errors will be indicated by ☑️ and a check in one of the following checkboxes:

   **Missing Value**: Mandatory data (according to the mapping) that has not been set.

   **Type Mismatch**: For instance when a text has been provided in a date field. Mapping to the destination format is not possible in this case.
Truncated: Note that all the text in the original Excel file can be imported and it will be cut to match the destination limitations.

11. After preview; optionally click on Check for Duplicates to verify if the data has already been imported before. Possible duplicates will be indicated with a dedicated check mark in the main grid.

12. Once the data has been checked for duplicates you can select whether to **Import All** or only **Import Non-Duplicates**.

13. Click on **Import** to import the data into goCASE. After you have clicked on Import, please wait. Larger files need longer to import.

*Note: When importing phone numbers and doing analysis, make sure that analysis is done on the complete number and not only on the split up numbers.*

### 5.8.5 Communication Analysis / Financial Analysis

The functionalities of the analysis component are identical for both Communication as well as Financial Analysis. The below example uses the **Financial Analysis**.

To open the Analysis component select either **External Data / Communication Analysis** or **External Data / Financial Analysis** in the context menu for a Person, Organization or Phone.

For imported data the following functions are available:

- Analysis Summary
- Match Analysis
- Diagram
- Analysis Charts

**Analysis Scope**

In this tab, you can set the parameters for analysis. One or more accounts as well as one or more batches can be selected for analysis.

**Batch Data**

In this tab, the imported data appears in a tabular format with all the columns with/without the data. You can click on the **Optimize View** check-box to view only the columns, which have data in them. Each uploaded Excel file represents a Batch. It is possible to analyse multiple batches at once.

**Analysis Summary**

In this tab, summary of the bank transaction analysis is displayed.

The **Summary** will show the Target Bank Account, Total number of transactions, number of deposit transactions, sum of deposits, number of withdrawal transactions, sum of withdrawals and Account Numbers found.

The **Totals by Account number** will show the account number with the associated Object and the totals. If there is no associated object but the account number is matched to a number in a different import it will have a red flag in the first column.
**Case Management**

**Account Connected To** is for the account numbers in the previous grid which have red flags. When selecting the row with the red flag it will show the selected account number and the number it is associated with as well as the object if there is an associated object.

**Match Analysis**

The Match Analysis Tab compares all data from the batch against potential matches within goCASE. The match score indicates the probability of a match against a goCASE object.

The match score takes into consideration the following attributes:

**Phone Entry:** ISTD, STD and Device number  
**Account:** Account number, Account Name

Unknown entries (no match in goCASE) will be shown in red in the main grid.

If there are multiple potential matches for a record they will be represented in the ‘Overview of Possible Matches’ grid at the bottom of the screen when clicking on 🎯.

**Display Matched Object:**

1. Click on either 📞 (Phone Analysis) or 💲 (Bank Transaction Analysis) to open a screen showing the details of the matched object in goCASE and also a list of the Cases the Person or Account is involved in.

2. Navigating directly to the Cases from within the dialog is possible.

**Pivot Chart View**

By default the Pivot Chart View shows the number of ‘connections’ (money flows, calls) between parties. The following functions are available:

- Highlighting of entries with a count higher than…
- Changing of displayed attributes, grouping
- Sorting
Diagram

It helps in the graphical representation of the connections between parties. The functionality is identical as for diagrams within the Case Files.

Analysis Charts

With this feature the batch data can be represented as charts for further analysis or presentation purposes.
6 Central Repository

The Central Repository is a case-independent, universal storage system for goCASE objects. It allows the user to reuse existing data objects of the following types: Persons, Organizations, Documents, Multimedia, Exhibits, Events, Notes, Bank Accounts, Vehicles, Firearm, Phones, Linked Cases, Diagrams and Authorities. The available list of Case Objects may vary depending on the Case File.

Objects in the repository can be reused in more than one case as necessary. For instance, the same gun could be involved in a series of crimes; having it in the central repository saves the user from having to enter the data over and over again for every new case.

Another advantage of repository objects is that when an object is updated, the update appears everywhere (i.e. in all cases) where the object is mentioned. For instance, if a new Owner/Holder of a suspicious car is discovered and added to the Vehicle object, the new Owner/Holder will be displayed in all cases in which the car is involved. To view the central repository and its contents:

1. Click on Central Repository in the toolbar, use the link Central Repository in the Menu panel of the goCASE Home tab or select Components > Central Repository from the menu. The repository view is loaded and displayed in a new tab:
On the top left corner there is a drop-down menu with object types.

1. Click on the **Search** button next to the drop-down list, to list all objects in the Central Repository, without any filtering.
2. To view objects of only a certain object type, select the object type from the drop-down menu and click on the Search button next to it.

   *Note: If the Object Type drop-down is <<All>>, it will search for all the objects within the central repository.*

3. You can filter the exact object within a specific Object Type by entering the Object Label name in the second textbox and clicking on the search button.
4. Double-Click on the specific object in the filtered result pane to open the object. You can display detailed information of the selected object on the right-hand panel.
5. Click on the **New Object** button to add a new object in the central repository.

### 6.1 Managing Repository Objects

The following functions are available:

- **Create Repository Object**: Add a new object to the central repository (see section 6.1.1: [Create Repository Object](#)).
- **Edit Repository Object**: Modify an existing object in the repository (see section 6.1.2: [Edit Repository Object](#)).
- **Link Object from Central Repository**: Connect a repository object with a case (see section 5.5.34: [Add Objects to Case File](#)).
- **Copy Repository Object to Case**: Create a local, independent copy of a repository object in a case file (see section 5.5.34: [Add Objects to Case File](#)).
- **Migrate Case Object to Central Repository**: Submit a local case object to the central repository for reuse (see section 5.5.12: [Migrate Case File Object to Central Repository](#)).

#### 6.1.1 Create Repository Object

Objects are usually entered into the goCASE database via cases in which they play a role and are later added to the central repository for reuse. However, it is also possible to create objects directly in the repository. To do this:

1. Select the Object Type from the drop-down menu for which you want to create a new object.
2. The **New Object** button is enabled.
3. Fill in the form. Add as much information as possible to facilitate searching in the future.
4. Save the object.
6.1.2 Edit Repository Object

To open an object in the central repository and edit it:

1. Click on an object link, in the left-panel of the central repository form.
2. Apply your changes to the data fields if necessary.
3. Save (✓) the object.
7 Search

In order to identify goCASE data correctly and reliably, two search functions are available:

**General Search:** Search for results within all case files registered in goCASE and the central repository (see section 7.1: General Search).

**Person Search:** Look up persons in case files and the central repository (see section 7.1: Person Search).
7.1 General Search

The General Search module allows the user to search in all case files in the goCASE database. The results now come sorted according to most recent create / revised entries like in the past day, week, month and year. The returned results contain a link to the respective case file and object where the result was found. To access the general search:

1. Click on General search link ( ) in the Menu panel of the Home tab or select Data → General Search from the menu. The search function is loaded and displayed in a new tab:

2. Enter the search term into the text field Search for.
3. Define the Search type:
   - Any word: Returns results containing any or all of the words in the search text. They will not necessarily be in the same order as in the search text and need not be next to each other.
   - Complete phrase: Returns only results containing the exact search phrase (not case-sensitive).
4. If you wish to only search for objects of a certain type (e.g. bank accounts), then select this type from the dropdown list Limit Results to Object Type.
5. If you would like narrow down your search to entries created or revisited in the past week/day/month or year, select the option accordingly in the Entries created or revisited field.
6. Click on Search. The results are retrieved and displayed in the lower part of the tab:
7. For consecutive searches: Activate the checkbox **Open results in new window** if you want to keep the previous results and display the new ones in an additional sub-tab; deactivate it if you want to overwrite the previous result list with the new results:

### 7.1.1 Result Information

Results are displayed for all case files and objects, regardless of security level. The only exception is files that have the security level “blind” and to which you have no access permissions (“Blind” case files to which you are permitted access are listed). Results from files of the second security level, “restricted by ACL”, to which you have no explicit access, are displayed as hits in the result list, but you cannot open and view the corresponding case files.

As seen above, the search results are arranged in a grid, showing the most important information at a glance.
7.1.2 Processing Results

The icons in the leftmost column show whether you can open and read the corresponding case file (✓) or whether you do not have access to its contents (‒).

1. Double-click a result to open the corresponding case file and show the indicated object.
2. If the result refers you to a document, double-click the “document” icon (❖) to directly open the document (in a suitable application) instead of the case file.
3. If you have two or more result tabs open and want to establish a combined search:
   i. Click on the Crosslink button or open the context menu of the result and select Crosslink. A pop-up window is displayed:

   iii. The window shows the search strings of the current result tabs and a check box next to each of them.
   iv. Activate the checkboxes of the search strings you want to combine and click on Run. A new result tab with the combined results is opened and displayed.

7.2 Person Search

This function enables you to search through the details of all Person objects entered into goCASE. This includes both persons in case files (see section 5.5: Electronic Case File) as well as persons in the central repository (see section 6: Central Repository). To access the person search:

1. Click on Person search (🔍) in the toolbar, on the Person Search link in the Menu panel of the Home tab or select Data ▶ Person Search from the menu. The search function is loaded and displayed in 2 tabs: Quick Search and Advanced Search.
You can now either perform a quick search or apply a more detailed search pattern.

7.2.1 Quick Search

2. Enter the first and last name you want to look for (or a part of them) into the field by name and click on Search. All matching persons are listed in the Search results grid:
3. Click on the CIN hyperlink to open and view the person object.

7.2.2 Advanced Search

1. Select the parameters you want to search for either from the tab Common Fields or All Fields and add them to the Search Parameters list.
2. For every parameter, define the Comparison Type, the Search Text and if it is an AND or an OR combination
3. Enter a descriptive Query Name into the text box after setting up the selected filter criteria
4. Click on Save Query to save the search query to be used for future
5. To start a new search by the saved Query names, select one of the names from the Saved Queries Field
6. To delete any already saved query, click on the delete button. The query will be deleted
7. Click on the CIN hyperlink to open and view the person object.

### 7.2.3 Comparison Types

- **[like]**: Result contains the search text
- **[=]**: Results match the search text
- **[<>]**: Results do not match to the search text
- **[>]**: Return results that are greater than the search text (numeric values only)
- **[<]**: Return results that are less than the search text (numeric values only)
- **[>=]**: Return results that are greater than or equal to the search text (numeric values only)
- **[<=]**: Return results that are less than or equal to the search text (numeric values only)

### 7.2.4 Result Information

Results are displayed for all person objects marked as **Shared for Read** and **Restricted by ACL**. Persons that have the security level **Blind** and to which you do not have access permissions are not returned as results (“Blind” case files to which you are permitted access are listed). Results from files of the second security level, “restricted by ACL”, to which you have no explicit access, are displayed as hits in the result list, but you cannot open and view the corresponding case files.

As seen above, the search results are arranged in a grid, showing the most important information at a glance. The icons in the leftmost column indicate whether you can open and read the corresponding person object (✔) or whether you do not have access to its contents (✘).

### 7.3 External Search

This function allows you to load an excel spreadsheet into goCASE, map columns to existing columns and run a search against the data in the spreadsheet. This is currently only relevant for the Person Object.

#### 7.3.1 Load Data

1. **Click on External Search (🔍) in the toolbar**, on the **External Search** link in the **Menu** panel of the **Home** tab or select **Data ► External Search** from the menu. The search function is loaded and displayed in a new tab:
2. **Click on the Browse button on the External Search form**
3. **It opens the Excel Sheet Selector window**
4. **Browse to select the compatible excel file for upload**
5. **Select the relevant worksheet of the Excel file by selecting it in the Sheet drop-down menu**
6. **Click on Load Data File button**
7. **Once the main grid is uploaded with the spreadsheet data, right-click on any specific cell on the data grid**
8. **A small pop-up appears**

   ![Search for Matches](image)

   **Note:** At the same time the column-header in the main grid changes to red. This indicates which column you are trying to find matches to.

9. **Clicking on this pop-up, invokes the External Search window with match criteria**
10. Once the matching criteria has been selected, click on the OK button.

11. In case there are matches, the results are displayed on the lower grid.

12. If there are no matches found, a message pops up, “The search text was not found”.
8 Suspect Index

The Suspect Index is a list of goCASE persons that are deemed to be suspicious and may include other persons than those directly involved in a case. The user must manually add such a person to the index list. Only persons added to at least one case file can be declared to be Suspects. To view the suspect index:

1. Click on Suspect Index () link in the Menu panel of the Home tab or select Components  Suspect Index from the menu. The index is loaded and displayed in a new tab:

The suspect index tab returns information which is displayed in several different panels.

Note: The suspect index is only a viewer. To add, edit or remove a suspect you must do so directly in the relevant person object.

Suspects List: All suspects currently on the list. Select a person from the list to view their details in the other panels.

Quick Filter: Enter a string into this field to narrow down the list of suspects to the ones containing this string in the name.

Related Cases: A list of all cases with which the selected suspect is connected. Click on the CIN link to open the case and this person object within it. Cases marked with ✔ allow you write access to the person.

Suspect Info / Address / Photos: Any personal information about the suspect.

Offences: Any offences this person is suspected of or has been charged with.
9 My Diagrams

Using the My Diagram feature, a user can access all the diagrams that he/she has created and want to access. A user can create personal diagrams for visualizing connections between all cases and repository objects that the user has access to. It only displays a list of “diagrams” that are intended for the logged in user. Each user adds his/her own diagrams under My Diagrams. My Diagrams is not linked to any case nor can it be attached to any case.

1. Select My Diagrams (_drag) from the menu.
2. My Diagrams window pops up displaying all the diagrams that you have created and added to it.
3. Double-click on any of the listed diagrams to open and work on it (add, edit, delete).
4. You can create a new diagram by clicking on the New button.
5. It opens a new screen with all the diagramming objects and diagramming toolbar. (see 5.6.16 Object Diagrams)
6. Click on (+) to add a new Object to the diagram. It opens up the Object Picker. You can choose between Case Objects or Diagram Objects.
7. Country Objects can be added by double-clicking on any of the listed countries in the Diagram Objects tab of the Object Picker.
8. Right-clicking on the digram object will open a context-menu with the following options.

9. You can visualize the connections to any selected country object for all the below options by clicking on them.

10. Save your Diagram with a name. The next time you open it from My Diagrams, it will open with the latest changes which were made to the diagram.
10 Content Management

The **Content Management** component is the document management tool in goCASE. It provides a secure environment for storing documents that are not necessarily related to particular case files.

The same rigid security policy applied to all components of goCASE is applied to the content management component: Every user has his or her own personal document folder to which only he or she has access to. When the user display name changes, it adds a new personal folder to the content management folders.

To share documents with other users, you must explicitly have to grant permission to allow the user(s) view or edit the selected content. However, there is a public folder which is visible to all users in the system. This folder can be used for storing templates, guidelines and other general documents. To open the content management module:

1. Click on **Content management** on the **Content Management** link in the **Menu** panel of the **Home** tab or select **Components > Content Management** from the menu. The content viewer is loaded and displayed in a new tab:

The tab is divided into two panels. The left-hand panel shows the visible part of the content management system as a tree structure, with views on **All accessible files**, **My folder** for the personal files and **Public** for the public files. The right-hand panel shows either the available files in the active folder (tab **Files**) or the list of search results (tab **Search Results**).

2. Click on a folder to display its contents in the **Files** tab.
3. Click on **Refresh** to update the view.
4. The Files tab has two different views, the “card” view and the “grid” view.
5. Click on **Toggle** to switch between the two views.
10.1 The Card View

The card view shows the files in the folder as “cards”. When you select a file, the information contained within the file is presented in the lower part of the panel:

10.2 The Grid View

The grid view shows the files as a table:

The functions:

The following functions are available. When you select a file, the file information is shown in the lower part of the panel:

- **Manage folders**: Create, edit and delete folders and set access permissions (see section 10.3: Manage Content Management Folders).
- **Manage files**: Edit file properties, open or delete files
- **Search**: Search for files in the content storage.
10.3 Manage Content Management Folders

The goCASE content management system allows you to add both personal and public folders. Existing folders can be edited and deleted if necessary.

*Note:* You can only create sub-folders to these two categories, not new root folders.

10.3.1 Add Folder

To add a new folder to the content tree:

1. Open the context menu of the folder for which you want to create a sub folder and select *Add folder*. An input dialogue window is displayed:

2. Enter the name of the new folder into the field *Folder Name*.
3. If the folder is to contain a specific type of files (e.g. images), select the appropriate type from the drop-down list *Folder Type*.
4. Click on *OK*. The new folder is created and shown in the content tree:

*Note:* Even if you have categorized a folder (e.g. as “Images”), you can still store files of any type in them.

10.3.2 Edit Folder Properties and Security

To modify the properties of a folder:

1. Open the context menu of the folder and select *Properties*. The folder properties window is displayed:
2. In the tab Details, change the Folder Name or Folder Type, if necessary.
3. Switch to the tab Security if you want to edit the access permissions of the folder:

4. Add access permissions for users or groups:
   i. Click on Append (●) in the footer of the grid. The Resource Selector is displayed.
   ii. Select the users or groups to whom you want to give permission (see section 3.9: Resource Selector for details).
   iii. Activate all checkboxes for the permission you want to grant to the user/group.

5. Remove permissions by clicking on Delete (●) in the footer of the grid.
6. When finished, click on OK. The new permissions are applied and the dialogue window is closed.

10.3.3 Delete Folder

To remove a folder from the goCASE content management system:

1. Open the context menu of the folder and select Delete Folder.
2. After a security check, the folder is deleted.
10.4 Manage Content Management Files

Managing files is the core function of the goCASE content management system. You can add files to the content storage, edit file properties, view file contents and remove files, if necessary.

10.4.1 Add a Single File

To add one file to a folder in the content management system:

1. Open the context menu of the folder for which you want to create a sub-folder and select **Import File**. A selection window is displayed:

![Add New File Window](image)

2. Click on **Browse** to look for the file in the file system. The operating system’s file chooser appears. Use it to select the file.
3. Enter a descriptive name for the file into the field **File label** (mandatory) and a Description (optional).
4. Click on **Upload**. The document is uploaded to the content management system.

10.4.2 Add Multiple Files

To add a larger number of files in one step:

1. Open the context menu of the folder in which you want to create a sub folder and select **Import Multiple Files**. The operating system’s file chooser appears.
2. Use it to select the first file. The **Load Multiple Files** window is displayed and already contains the first file:
3. Click on Add to list ( ). The file chooser reappears.

4. Continue adding files this way until the list is complete.

5. Select a listed file and click on Remove from list ( ) to remove an obsolete list entry.

6. Click on OK. The selected files are uploaded to the goCASE database.

   Note: In this case the file label is set automatically.

10.4.3 Edit File Properties

   To edit the properties of a file in the goCASE content management system:
   1. Select the File from the grid and right-click to open the context-menu
   2. Select Properties

   3. Edit the properties as necessary in both the tabs.
10.4.4 Set File Security Settings

To make the selected file available for other users (or remove such permission):

1. Click on **File Security**. The **File Properties** window is displayed:

![File Properties Window](image)

2. Add access permissions for users or groups:
   
i. Click on **Append** (++) in the footer of the grid. The Resource Selector is displayed.
   
   ii. From there, select the users or groups to whom you want to give permissions to (see section 3.9: Resource Selector for details).
   
   iii. Activate all checkboxes for the permission you want to grant to the user/group.

3. Remove permissions by clicking on **Delete** (−) in the footer of the grid.

4. When finished, click on **OK**. The new permissions are applied and the dialogue window is closed.

10.4.5 View File

To view a stored file:

1. Double-click the file in the Files tab (any view).

The file is opened in a suitable application.

10.4.6 Delete Files

To remove obsolete files from the content management system:

1. Select the file in the **Files** tab.
2. Click on **Delete** (−) in the footer of the tab.

Following a security check the file is deleted.

10.4.7 Upload to Case File

You can upload documents from the Content Management folders into a Case File.

1. Right-Click on a document and select the option **Upload to Case File**
2. Select the check-box next to the document that is to be uploaded.
3. Enter the **CIN** of the Case File in the Load Multiple Documents window where it needs to be uploaded by clicking on the **Select Destination Case** button.

4. Click OK to confirm the upload.
10.5 Search Content Management System

The content management system (see section 10: Content Management) provides a quick search function to allow the user to locate files easily:

1. Enter a search string into the field Search.
2. Click on Search (Δ). The results are retrieved and shown in the Search Results tab:

3. Click on the File Name link of a result to open the file in a suitable application.
11 Photo Montage

The Photo Montage module allows user to create a virtual line-up of Suspects/Informants/Complainants/Accused/Information Provider/Witness/Surety/Suspect Attorney etc. All persons that are linked to the Case in any of the above roles and registered in goCASE are made available for display. This allows you to identify and eliminate suspects without having to assemble them in one place.

1. Click on Photo Montage ( ) in the toolbar, on the Photo Montage link in the Menu panel of the Home tab or select Components → Photo Montage from the menu.
2. A new tab opens with the names of all the Persons and their links to the Case with information and images.
3. You can filter the list by selecting one of the options from the Link to the Case drop-down field.
4. You can then click on the (…) to select the Case File to which the person is linked and then Click on the Search icon.
5. Select the Include Central Repository check-box if you want the persons other than the ones in the selected Case File to be included.
6. You can narrow down the search by using Quick Filter option in this form.
7. Double-click on a name in the List to add his or her photo to the Image View. Repeat this until you have lined up all persons you want to present in the line-up.

8. Select a photo to show the person’s details in the Person Information panel.

9. Collapse the Person Information panel before presenting the line-up to the witnesses:

Note: If a person object does not yet contain a photo, a dummy image is displayed instead.

10. To remove an image from the Image View, select a name and click on Delete in the footer of the Image View panel.
12 Special Lists

Person objects in goCASE can be added to special lists such as watch lists or an index of missing persons. Such lists can be viewed in the Special Lists module:

1. Click on Special Lists (Special Lists) in the Menu panel of the Home tab or select Components ▶ Special Lists from the menu. The lists viewer is loaded and displayed in a new tab:

The available special lists are shown in the Special Lists panel of the tab.

**Note:** Special lists are subject to customization; please note that your organization may have different list types.

2. Select a list from the Special Lists panel. All current members of this list are displayed in the Person List grid.
3. Select a person from the Person List.
4. All cases in which this person is involved are shown in the All possible matches… grid.
5. If the person object also appears in the central repository (see section 6: Central Repository), this is also shown here.
6. The Person appears in the following lists grid shows you the lists in which this person appears.
7. Click on a Case File link in one of the grids to open this case file and display the person object within the file.
8. To remove the active person from the selected special list:
9. Select the list in question from the Person appears in… panel.
10. Click on Delete (Delete) in the footer of the grid. Following a security check, the list entry is removed.
13 Exhibit Registry

The Exhibit Module allows you to track the movement of any exhibit within goCASE. The evidence in a case relies on the consistent monitoring/tracking of the exhibit from the moment it was seized or located via all examinations to the moment it is presented to the court. Furthermore, data collected during this process can be added to the exhibit.

1. Click on Exhibit registry link in the Menu panel of the Home tab or select Components Exhibit Registry from the menu. The registry editor is loaded and displayed in a new tab:

2. The Case File Overview contains a list of all exhibits registered in goCASE, grouped by case identification number (CIN). The Search Criteria panel allows the user to narrow down this list.

3. Expand a case number to view all case exhibits.

4. Click on an exhibit in the Case File Overview to show the movement details of this exhibit in the bottom grid.

5. You can either search for a special exhibit (see section 13.1: Search Exhibits) or add a new movement to an existing exhibit (see section 13.2: Add Movement to Exhibit).

Note: New exhibits are created in the case files they belong to, not in the exhibit registry.
13.1 Search Exhibits

To search for a specific exhibit (see section 13: Exhibit Registry) in the goCASE database:

1. Define one of the following search criteria:
   
   i. Enter the case identification number (or part of it) into the field CIN.
   
   ii. Enter a known Movement reference number of an exhibit (or part of it) into the appropriate field.

   iii. To search for the exhibits that a certain person currently has in his or her possession, click on Browse () in the Signed out to field. The goCASE resource selector is displayed. Use it to select the desired person (see section 3.9: Resource Selector for handling details).

2. Click on Search. The Case File Overview list displays all entries matching the search criterion.
13.2 Add Movement to Exhibit

Movements are tracked on exhibits in the goCASE database where the exhibit is transferred from one person or location to another (see section 13: **Exhibit Registry**). To add a movement to an exhibit:

1. Click on Append (+) in the footer of the movements grid. The **Movement Details** dialogue window is displayed:

![Movement Details Window]

2. Enter the following information (fields marked with an asterisk are mandatory):
   i. **Movement Date**: Select the actual date on which the exhibit was moved.
   ii. **Movement Type**: Select one of the available types from the drop-down list (e.g. “Return to owner”).
   iii. **Received From**: Click on **Browse** (⿅). The goCASE resource selector is displayed. Use it to select the person handing over the exhibit (see section 3.9: Resource Selector for handling details).
   iv. **Signed Out To**: Use the resource selector to determine the person receiving the exhibit.
   v. **Comments**: Enter the necessary information regarding the movement into this field.

3. Click on OK. The movement is added to the list and the dialogue window is closed.

*Note: Movement details cannot be edited.*
14 Reports

goCASE offers a flexible reporting system for management reporting, ad-hoc queries and statistical analysis. Case information can be analysed to establish trends and patterns.

1. To open the reporting component, click on the Reports tab in the quick-access bar (see section 2.3: The Quick-Access Bar) or the Reports icon on the Dashboard. The reports selector is displayed:

   ![Reports Selector Image]

   The reports selector consists of two panels: All Reports shows all goCASE reports to which you have access in a hierarchical list whereas Favourites allows you to list your preferred reports for easier access.

   2. Expand (a) a report type to view all the reports it contains.
   3. To add a report to your Favourites, drag the item from the regular panel to the Favourites panel.
   4. To delete from the Favourites panel, click on it then hit delete.
   5. You can now run reports
   6. Run Report

Note: If you need access to more reports, contact your goCASE administrator.

14.1.1 Run Report

To run a report, you must first launch the report, set the parameters and retrieve the data.
14.1.2 Launch Report

To launch a report, double-click on the desired report in the reports selector (see section 14: Reports). The editor for the selected report is opened in a new tab:

![Report editor](image)

14.1.3 Set Report Parameters

Most reports require one or more parameter settings before the result can be calculated and displayed. These parameters can be of totally different data types; for instance:

- **Input fields:** Some reports offer fields for entering free text (such as person names in the “person profile” report or CINs). Enter the full string or part of it into the field.
- **Selection fields and radio buttons:** For some reports, predefined selection fields are provided. These can be drop-down lists (e.g. for selecting a country or an offence type) or radio buttons (such as the custody status of a person); however, the underlying functionality remains the same.
- **Dates:** Reports covering a specific period of time (e.g. the “user activities” report seen above for September 2010) have fields for determining the start and end dates of the viewed period. Select a standard period from the **Quick date** drop-down lists or use the **User-defined range** fields for determining individual start and end dates.
- **Resources:** To filter by resource click on “Browse” (open) and select the resource using the **Resource Selector** which appears on the screen (see section 3.9: Resource Selector).

**Report Info:** This box is available for all reports. From here you can select a **Report layout** (and with it the data to be displayed) and determine whether the results should **display the user name** and be **filtered as per ACL** (access control list).

**Note:** Parameters marked with an asterisk are mandatory.
14.1.4 Retrieve result data:

To retrieve and display the results, click on Retrieve data (_fact) or hit <F12> on the keyboard. The report is executed and the results are displayed in the lower part of the tab.

**Note:** Depending on the amount of data and your database connection, retrieving results can take quite some time, during which goCASE does not respond.

14.1.5 Result Views

goCASE Reports results are presented in two formats: The display version, which is a simplified presentation that shows results in a tabular format and the document version, a more formal format geared towards official communication. The display version is shown in the Report Data sub-tab of the report:

![Report Display Version](image)

The printable document version of the report can be displayed by clicking on the icon on the Toolbar.
14.1.6 General Report Processing Functions

All goCASE reports share a number of common features and functions. A number of them can be easily accessed via the goCASE toolbar (see section 2.2: The Toolbar):

Clear data (✓ or <F11>): Resets the query criteria to the default values.

Retrieve data (✓ or <F12>): Runs the report with the current query parameter settings and retrieves the result data.

Print (✓): Prints the active report.

Create chart (✓): Creates a chart from the active report using certain user-defined settings (see section 14.2: Report Charts).

Export to PDF (✓): Exports the report in PDF file format to the file system.

Export to Excel (✘): Sends the report to Microsoft Excel (Excel has to be installed on your computer).
14.2 Report Charts

You can create a chart for every report result to illustrate the figures; goCASE offers numerous ways for presenting the numeric data.

1. After you have retrieved the report results (see section 14.1.1 Run Report), click on Create chart (_reports) in the toolbar or select Data ▶ Create Chart from the menu. A new, empty chart tab is displayed:

2. Select the data to be shown in the X Axis and Y Axis from the corresponding drop-down lists.
3. Select the Type of chart you want to draw (pie, bar…).
4. Select the colours you want to use and any additional information (such as the legend or a title for the chart) you wish to include.
5. Click on Draw Series. The chart is drawn in the right-hand panel of the tab:
6. To show more than one result of the same data in one chart, click “Add series” in the Series List field. This will allow you to select another Y Axis. Click on Draw Series to show the chart.

7. Click on Print Chart to print the chart graphics or on Save Chart Image to save it as a JPG image to the file system.
# 14.3 Reports Overview

Depending on the user access permissions, the following reports can be generated:

<table>
<thead>
<tr>
<th>Category</th>
<th>Reports</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System Administration</strong></td>
<td>Table Statistics, User Activities, Case File Access Log, Object Creation Log</td>
</tr>
<tr>
<td><strong>Analysis</strong></td>
<td>Offence Distribution by Address</td>
</tr>
<tr>
<td><strong>Statistical Indicators</strong></td>
<td>Cases, Sites, Status, Operations, Performance</td>
</tr>
<tr>
<td><strong>Investigation</strong></td>
<td>Person Profile, Suspects in Custody, Case Action Diary, Person Index, Special Lists, Crime Diary, CR Persons, Objects Catalogue, Social Network, Connected Objects</td>
</tr>
<tr>
<td><strong>Management</strong></td>
<td>Resources, Ongoing Investigations, Case by Handlers, Status by Region, Case Statistics, Case Job Lists</td>
</tr>
<tr>
<td><strong>My Reports</strong></td>
<td>My Events, Workflow Log, Cases I have worked on</td>
</tr>
<tr>
<td><strong>Prosecution</strong></td>
<td>Court Case Handling, Prosecution Details, Convictions</td>
</tr>
<tr>
<td><strong>Statistics</strong></td>
<td>Case by Offence, Case Reception Log, Financial Impact, Person Count by Age, Yearly Distribution</td>
</tr>
</tbody>
</table>
## Reports

<table>
<thead>
<tr>
<th>Yearly Distribution by Status</th>
<th>Illicit Drug Seizures</th>
</tr>
</thead>
<tbody>
<tr>
<td>PEN Trading Log</td>
<td>PEN Trading Parties</td>
</tr>
<tr>
<td>Case Registration Office</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Case by Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Workflow Actions</td>
</tr>
<tr>
<td></td>
<td>Workflow Transition Statistics</td>
</tr>
</tbody>
</table>

See below for the features of the different reports.

**Note:** The “Report Info” is basically the same in all reports and will not be mentioned here (see section 14.1.1 Run Report)

### 14.3.1 Table Statistics

**Function:** Shows how many entries are contained in a specific goCASE database table.

**Parameters:** Date from/to.

**Result:** Table name, From date, Row Count, To Date, Row Count, Difference.

### 14.3.2 User Activities

**Function:** Lists the logins and logouts of the selected Resource in the given time frame.

**Parameters:** Date from/to, Resource.

**Result:** Resource Name, IP address, Action, Action Date.

### 14.3.3 Case File Access Log

**Function:** Shows a log of when a specific case file was accessed and by whom

**Parameters:** Date from/to, CIN, Resource

**Result:** CIN, Internal Case Reference, Case File Name, Access Date, Access Time, Resource Name

### 14.3.4 Object Creation Log

**Function:** Lists all the objects created and the Resource, that created them

**Parameters:** Date from/to, CIN, Object Type, Resource

**Result:** CIN, I.Ref. No., Case File Name, Resource Name, Object Type, Object Label, Date Created

### 14.3.5 Cases, Sites, Status

**Function:** Displays the different report types in a defined time period: status by offense, status by registration office, status by site, total by trigger type, total by delivery method and site, total by delivery method and registration office, total by level of importance by site as per the filter

**Parameters:** Report, Initiating Office and Case Type

**Result:** Case Type, Site, Status
14.3.6 Operations
Function: Displays reports filtered by Arrest Orders by Occupation and Site and reports by arrest orders by Occupation and Registration Office
Parameters: Initiating Office, Case Type, Date from/to
Result: Case Type, Year, Registration Office and Arrest (in custody)

14.3.7 Performance
Function: Displays reports filtered by Financial Items by Site, Financial Items by Registration Office and Investigator Assignments
Parameters: Initiating Office, Case Type, Date from/to
Result: Case Type, Year, Site Name, Fraud/Presumptive Fraud and Theft

14.3.8 Person Profile
Function: Displays a list of all persons in case files which contain part or all of the submitted name.
Parameters: Person name.
Result: CIN, Case File Name, Full Name, Link to Case, title, gender, marital status, date of birth, occupation, country, city, nationality, state, (default) photo.

14.3.9 Case Action Diary
Function: Returns events and tasks added to the action diary for the specific case file.
Parameters: CIN, internal case reference, operational code name, content type.
Result: Action, action title, start date, end date, action type, action status, location, description, content type.

14.3.10 Person Index
Function: Returns a list of persons and their offences in the selected way they are linked to the case (suspect, witness…).
Parameters: Link to case.
Result: CIN, family name, first name, middle name, date of birth, year of birth, file name, internal reference no., link to case, offences.

14.3.11 Case Action Diary
Function: Returns the case extracts of the selected case files within a given period.
Parameters: Date from/to, CIN, Internal Case Reference, Operational Code Name, Location
Result: Action, Action Title, Start Date, End Date, Action Type, Action Status, Location, Event Description and Content Type.

14.3.12 Crime Diary
Function: Returns the Case Extracts of all the selected Case Files of the selected Case Types
Parameters: Date from/to, CIN, Case Type
Reports

Result: Case CIN, Case File Name, Internal Case Reference, Trigger Received Date, Initial Case Type and Case Extract

14.3.13 CR Persons
Function: Lists all the persons in the central repository and show their links to case files.
Parameters: (none).
Result: Access, person, CIN, case file name, link to case, offence.

14.3.14 Objects Catalogue
Function: Returns a list of all objects of the selected object type.
Parameters: Object type, including central repository.
Result: CIN, object type, object label.

14.3.15 Social Network
Function: Shows the social network of the selected person; i.e. to whom he or she has connections to and of which type.
Parameters: Person name.
Result: Connected to, connected as.

14.3.16 Connected Objects
Function: Shows the objects connected to the selected object and the type of connection.
Parameters: Object
Result: Object type, object label, connection rule, link description, link created by, link created on.

14.3.17 Resources
Function: Returns a list of all resource groups as well as all the users belonging to these groups. Data is also displayed in Organizational Structure by clicking on the Organizational Structure tab
Parameters: (none).
Result: Group Name, City, Group Main Function, Group Parent, Resource, Assistant Resource

14.3.18 Ongoing Investigations
Function: Returns a list of all ongoing investigations at a specific site.
Parameters: Originating site.
Result: CIN, file name, internal reference no., case site, offence description, case officer, handling unit, received date, case started, elapsed days.

14.3.19 Case by Handlers
Function: Returns the number of cases and their status according to the given parameters.
Parameters: Date from/to, site, current handling unit, case type, status.
Result: Site, current handling unit, status, current transition owner, case officer, no. of cases.

14.3.20 Status by Region
Function: Returns the number of cases broken down by workflow states and originating site.
Parameters: none
Result: Sites, no. of cases within each workflow state

14.3.21 Case Statistics

Function: Displays all the statistics related to the Case File
Parameters: Date from/to, Originating site
Result: CIN, Internal Case Reference, Trigger Type, Current Status, Case Officer, Case Life Duration

14.3.22 My Events

Function: Lists all events for which the current user is listed as a resource or where the current user is a member of a group listed as a resource.
Parameters: Date from/to.
Result: CIN, case file name, event title, event type, location, start date, end date, event status, attendance.

14.3.23 Workflow Log

Function: Lists all cases and transition states in the given period where the current user was or is the owner.
Parameters: Date from/to.
Result: CIN, case file name, cycle, transition state, in date, out date.

14.3.24 Cases I have worked on

Function: Shows all cases where the active user is either first case officer, second case officer or added as a case worker.
Parameters: (none)
Result: CIN, case type, received date, file name, case first officer, case second officer, status, extended status, assigned to, security level, classification.

14.3.25 Case by Offence

Function: Returns a list of primary and secondary offences as well as the number of cases which revolve around these offences. The percentage is calculated over the total number of cases.
Parameters: Date from/to, offence primary category.
Result: Offence primary category, offence second category, count of cases, percentage.

14.3.26 Case Reception Log

Function: Lists the cases of the selected site which have been received within a given time frame (i.e. registered through the “initiate new case” feature).
Parameters: Date from/to, originating site.
Result: CIN, file name, internal reference no., originating site, received date, trigger type, method of delivery, case trigger initiator, offence place, offence description, handled by, current status, and owner.
14.3.27 Financial Impact

**Function:** Displays the financial impact registered in the case details for the selected item type.

**Parameters:** Date from/to, items, currency conversion, currency.

**Result:** Item type, no. of cases, value, currency.

14.3.28 Person Count by Age

**Function:** Returns a statistic of the number, gender and average age of people connected with selected offence types.

**Parameters:** Date from/to, primary offence, secondary offences, gender, include persons with no date of birth and link to case.

**Result:** Primary offence, secondary offence, gender, age, count, last name, first name, date of birth, CIN, file name.

14.3.29 Yearly Distribution

**Function:** Returns the number of primary and secondary offences of given types in the selected years.

**Parameters:** Start year, end year, primary offence, and secondary offence.

**Result:** Primary offence, secondary offence, count.

14.3.30 Yearly Distribution by Status

**Function:** Lists the total number and (in percent) of cases per workflow status

**Parameters:** (none)

**Result:** Year, Yearly Total, Status, Total by Status, Percent of Status

14.3.31 Cases by Clients

**Function:** Displays all the Case CIN by their Reporting Officer

**Parameters:** Date from/to

**Result:** Case CIN. Initial Case Type, Reporting Office, Acronym

14.3.32 Case by Status

**Function:** Lists all the Cases within all Case Types with their respective current status and position in WF Cycle.

**Parameters:** (none)

**Result:** Case Type, CIN, File Name, File Create Date, Handled By, Current Status, Extended Status, Position in WF Cycle, Current Owner, Elapsed Days, Security Level

14.3.33 Workflow Actions

**Function:** Lists all the Cases by their Type, Workflow Action, Date, Status etc.

**Parameters:** Date to/from, Originating Site, Case Type, Transition

**Result:** CIN, Case Type, Originating Site, Workflow Action. Action Completed By, Action Status
14.3.34 Workflow Transition Statistics

**Function:** Displays the workflow transition statistics of a Case File

**Parameters:** Date from/to

**Result:** Case CIN, Initial Case Type, Originating Site, Internal Case Reference, Trigger Received Date, Transition Status, Status Owner and File Forwarded to